Migrating to FlexNet Manager
Suite 2015 On Premises

FlexNet Manager Suite 2015 | Contents | 2

Contents
Chapter 1: Migrating to FlexNet Manager Suite 2015 on Premises.............. 5

Process Overview..............................................................................................................................................................6
Design the Final Topography......................................................................................................................................... 13
Prerequisites and Preparations........................................................................................................................................ 17
Locate License Details.......................................................................................................................................17
Identify (or Set Up) Accounts...........................................................................................................................18
Isolate the System..............................................................................................................................................19
Check Database Collation Sequence................................................................................................................. 20
Configure .NET and IIS.................................................................................................................................... 20
Upgrade PowerShell on Inventory Beacons..................................................................................................... 23
Configure Internet Explorer...............................................................................................................................24
Drivers for Spreadsheet Imports....................................................................................................................... 24
Download the Materials.....................................................................................................................................25

Chapter 2: Preparing Inventory Manager.....................................................27

Identify and Update Inventory Manager Server.............................................................................................................28
Prepare Managed Device Self-Upgrade Package...........................................................................................................33
Configure setup.ini.............................................................................................................................................35
Distribute Self-Upgrade and Settings Packages............................................................................................................. 36
Targeting the Inventory Agent Upgrades and Migration............................................................................................... 37
Splitting a Shared Database............................................................................................................................................40

Chapter 3: Upgrading FlexNet Manager Suite..............................................42

Upgrade/Create Databases.............................................................................................................................................. 43
Database Validation........................................................................................................................................... 48
Authorize the Service Account.......................................................................................................................................49
Install the Web Interface................................................................................................................................................ 50
Install the Inventory Server............................................................................................................................................ 51
Install the Batch Processors............................................................................................................................................52
Configure the System......................................................................................................................................................53
(Re-)Activate the Product............................................................................................................................................... 56
Populate the Downloadable Libraries........................................................................................................................... 57
Import the Sample Reporting Package..........................................................................................................................57
Configure Web Browsers................................................................................................................................................60
Link to Flexera Service Gateway................................................................................................................................... 60
Update Access Rights..................................................................................................................................................... 61
Deploying Inventory Beacons in Migration Mode........................................................................................................ 62
Set Defaults and Migration Mode.....................................................................................................................64
Deploy Inventory Beacons................................................................................................................................ 64
Create a Roll-out Target....................................................................................................................................66
Migrating Citrix Inventory Collection............................................................................................................................69
Update the XenApp Adapter............................................................................................................................. 69
Update the XenDesktop Adapter.......................................................................................................................70
Finishing Off................................................................................................................................................................... 72

FlexNet Manager Suite 2015 | Contents | 3

Chapter 4: Notes on Issues.............................................................................. 75

Password Maintenance.................................................................................................................................................... 76
Identifying IIS Application Pool Credential Issues........................................................................................................77
Update Credentials in IIS Application Pools.................................................................................................... 78
IIS Roles/Services........................................................................................................................................................... 79

Legal Information

Legal Information
Document Name: Migrating to FlexNet Manager Suite 2015 on Premises
Part Number: FMS-10.3.0-UG01
Product Release Date: 15 April 2015

Copyright Notice
Copyright © 2015 Flexera Software LLC. All Rights Reserved.
This publication contains proprietary and confidential technology, information and creative works owned by Flexera
Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission
of such publication in whole or in part in any form or by any means without the prior express written permission of Flexera
Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this
publication shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights,
whether by estoppel, implication, or otherwise.
All copies of the technology and related information, if allowed by Flexera Software LLC, must display this notice of
copyright and ownership in full.
FlexNet Manager Suite incorporates software developed by others and redistributed according to license agreements.
Copyright notices and licenses for this externally-developed software are provided in the link below.

Intellectual Property
For a list of trademarks and patents that are owned by Flexera Software, see http://www.flexerasoftware.com/intellectualproperty. All other brand and product names mentioned in Flexera Software products, product documentation, and marketing
materials are the trademarks and registered trademarks of their respective owners.

Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, department, or other
entity of the United States Government, the use, duplication, reproduction, release, modification, disclosure, or transfer of the
Software, or any related documentation of any kind, including technical data and manuals, is restricted by a license agreement
or by the terms of this Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense
Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was developed fully at private
expense. All other use is prohibited.

Flexera Software "Company Confidential"

Migrating to FlexNet Manager Suite 2015 On Premises

4

1
Migrating to FlexNet Manager Suite 2015
on Premises
Topics:
•

Process Overview

•

Design the Final Topography

•

Prerequisites and Preparations

Note • This document does not cover upgrading from FlexNet Manager Suite 2014
(any revision) to FlexNet Manager Suite 2015. For that simple process, see Upgrading
FlexNet Manager Suite 2014 Rx to 2015 on Premises. As well, managed service
providers (MSPs) should see the separate documentation for multi-tenant environments,
Migrating to FlexNet Manager Suite 2015 for MSPs.
FlexNet Manager Suite is a powerful and sophisticated tool, which has been extensively
rewritten since FlexNet Manager Platform 9.2, with a new user interface and some
significant back-end changes. Therefore migration is a significant project. Planning your
upgrade is made more challenging because there are many different configurations of
the 9.2 product, each of which represents a different starting point to migrate to the 2015
release. This document covers the major starting points, and includes consideration of
functionality required going forward.
This document is intended for use by:
•

System engineers responsible for implementing and maintaining the system

•

Network and security personnel with responsibility for infrastructure that the system
relies on

•

Flexera Software consultants implementing your system.

Assumptions: Readers have completed at least the appropriate training course in FlexNet
Manager Suite administration, and understand basic product concepts. Readers have a
technical background and are experienced with product installations and configuration.

Migrating to FlexNet Manager Suite 2015 on Premises

Process Overview
When upgrading to FlexNet Manager Suite 2015, there are several possible starting points, each causing variations in the
process. You may also desire a variety of possible outcomes. Having so many choices can make a guide like this seem
complicated. The following flowchart and description illustrates your choices. To simplify further, you may wish to highlight
the path through the possibilities that applies to your enterprise. The discussion that follows references each step in the flow
chart by the numbers shown. The process outlined here has been proven successful, and you need to follow carefully.

Important • Not shown in the flowchart is an initial backup of your database(s) and also of your existing server(s), using your
normal backup procedures. In the unlikely event that you are dissatisfied with the result of this migration, the only 'roll back'
option is to restore these backups.
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1. Upgrading — The starting point
FlexNet Manager Suite 2015 is a single, integrated solution for license optimization. However, you may be coming to this
solution from a variety of starting points, such as:
1. FlexNet Manager Suite 2014. This is a simple upgrade path, for which a simplified document is available (see Upgrading
FlexNet Manager Suite 2014 Rx to 2015 on Premises).
2. FlexNet Manager Platform 9.2 or earlier; or its fore-runner Compliance Manager across many different releases. Provided
that any one of these products is installed on its own (specifically, without a co-installation of Inventory Manager on
the same application server), you may migrate this product directly to FlexNet Manager Suite 2015 using this guide. If
you also had a separate installation of Inventory Manager on another server, you may choose to upgrade it as part of this
project, or to consider its upgrade separately if you wish, since earlier versions of Inventory Manager can still integrate
with FlexNet Manager Suite.
3. Any of FlexNet Manager Platform 9.2 or earlier or Compliance Manager (any version) installed on the same application
server as Inventory Manager. This is the most challenging case, as FlexNet Manager Suite now has integrated handling of
its own inventory data, and no longer requires the separate Inventory Manager product. However, it is possible that you
may prefer to preserve Inventory Manager for some of its more fine-grained targeting capabilities.
The following discussion points clarify the issues and options around case 2 (either no Inventory Manager, or implemented on
a separate application server) and case 3 (co-installation on the same application server). (The question of a shared database is
treated separately below.)

2. Is Inventory Manager co-installed?
"Co-installed" here means that Inventory Manager and your previous compliance product were installed on the same
application server. You can usually tell whether Inventory Manager is installed with your earlier implementation by opening
the product in the MMC console. If, along with the FlexNet Manager Platform node, you see nodes like Managed Device
Settings, Discovery and Adoption, and Remote Task Manager in the console tree on the left, then Inventory Manager is coinstalled on the same server. In this case, you will need to commission a new server (or set of servers, virtual or physical) for
FlexNet Manager Suite 2015 alone. Your existing combined server rolls forward as your Inventory Manager (only) server, at
least for the time being, and we will uninstall your old FlexNet Manager Platform from this server in due course.
The rare exception is that you may have Inventory Manager installed, but on a separate server (question 2A). It will have its
own MMC interface on that server with the same kind of nodes in the console tree (but not the FlexNet Manager Platform
node). When Inventory Manager is separately installed like this, you may choose whether to:
•

Defer any upgrade of the Inventory Manager product to a separate project that you will tackle later. In this case, go
directly to step 5.

•

Include the upgrade of Inventory Manager in this same project, as documented here. In this case take steps 3 and 4.

If you do not have any implementation of Inventory Manager, your decision tree is simplified, and you race ahead to step 7
(down the N exit from step 2a).
Details: Identify and Update Inventory Manager Server on page 28.

3 and 4. Ensure that Inventory Manager is up-to-date.
For the upgrade process, the scripts to assist your process with database separation and clean-up are based on the schema at
9.2.3. For that reason alone, you need to have Inventory Manager up-to-date before proceeding.
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Also from a business perspective, if you plan to carry forward with Inventory Manager as an inventory source feeding
your system (an option we discuss later), you are likely to use release 9.2.3 of Inventory Manager, since it has additional
functionality particularly in relation to Oracle inventory gathering. So it will be convenient to complete this upgrade as part of
the same project.
For these reasons, there is summary guidance for upgrading Inventory Manager included in this document (see Identify and
Update Inventory Manager Server on page 28). If you want further information, use the Upgrade Guide installed with the
9.2 product to guide you.
Once you have done that, you are at the baseline to commence the upgrade to FlexNet Manager Suite 2015.

5. Do both products share a single database?
If, in step 2, you identified that your products were co-installed on the same server, then you do have a shared database as
well, so your answer here is Y.
If you have separate application servers, you may still have them sharing a common database. You could ask your DBA, or
you can check a registry key as described later. Details: Identify and Update Inventory Manager Server on page 28.
The upgrade process requires that a shared database is first split into two. One database is preserved for on-going operation of
Inventory Manager. The other can be upgraded to FlexNet Manager Suite 2015.

Tip • The minimum supported database release is Microsoft SQL Server 2008. You'll also notice that the new product
requires two or three additional databases that were not present in the 9.2 release (typically on the same database server).
If you are sure that your previous implementation already had separate databases (and on a supported version of SQL Server),
you can skip forward to step 7.

6. Split the databases
Separating the databases is required for the migration process. As well, since you may want to continue with Inventory
Manager functionality for some time, splitting the databases allows for one copy to migrate up to FlexNet Manager Suite 2015
while the other continues for Inventory Manager. You achieve this by:
•

Doing a backup of your current joint database

•

Doing a restore to make a second copy with a new name

•

Running the scripts provided to clean out from each database the content belonging to the 'other' product.

Details: Splitting a Shared Database on page 40.

7. Upgrade your compliance product to FlexNet Manager Suite 2015
If your earlier implementation had two separate servers for your compliance product and for Inventory Manager, you can
apply the software upgrade to your compliance server directly.
In contrast, if you previously had a single server hosting both compliance and inventory, you now commission a new
application server and install FlexNet Manager Suite 2015 as a fresh installation. (Details are provided for planning your
new implementation.) You can also uninstall the old compliance product from the previously combined server, which now
becomes your Inventory Manager server.
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In both cases, you also install an inventory beacon on your central application server. This 'home base' inventory beacon
allows you to continue managing the compliance connections recorded in your database in your previous implementation.
(Inventory beacons on separate servers cannot access legacy connections that were migrated from your 9.2 Inventory Manager
database into your FlexNet Manager Suite 2015 database. Only the local inventory beacon has database access.)
Full details for this step are included in the chapter Upgrading FlexNet Manager Suite on page 42.

8. Roll out your inventory beacon hierarchy
Your old Inventory Manager product possibly used a hierarchy of distribution servers to send out packages and upload
inventory collected by inventory agents installed on managed devices. (Around release 9.0, the distribution servers were
renamed inventory beacons; but to avoid confusion in this document, we will continue to call them distribution servers.)
Inventory beacons supplied with FlexNet Manager Suite 2015 are completely re-architected, and you should roll out a new
hierarchy of 2015 inventory beacons on separate machines (which can be virtual machines if you so choose).

Note • Inventory beacons for 2015 are not compatible with earlier distribution servers (including those for 9.2 or later that
were called inventory beacons), and cannot coexist on the same computer.
Exactly how you do this depends on your strategy, decided in the following steps. For example, if you want the fastest
possible automated switch-over, you simply replace the distribution server software with FlexNet Beacon software, as
described in more detail in step 12.
Your alternative strategy involves parallel operation of 9.2 inventory gathering with 2015 inventory beacons. Since these
cannot exist simultaneously on the same server, parallel operation requires that you roll out a parallel machine hierarchy.
Keeping both the old distribution server hierarchy and the new inventory beacon hierarchy operational in parallel allows for
an orderly transition. Later, if you decide to move away from Inventory Manager, you can decommission and re-purpose the
former distribution servers.
Details: Deploying Inventory Beacons in Migration Mode on page 62.

9 and 10. Using solely Inventory Manager 9.2 for FlexNet inventory collections?
Broadly, you need to decide what functionality from Inventory Manager you want to preserve, and for how long. FlexNet
Manager Suite 2015 deliberately simplifies management of FlexNet inventory agents on target devices. Consider this
functionality comparison:
Inventory Manager 9.2

FlexNet Manager Suite 2015

Choose between client-side policy merging and serverside policy merging. (Client-side policy merging was more
commonly used for deployment activities. Any managed
devices relying on client-side policy merging must continue
to be managed under Inventory Manager 9.2.)

Only server-side policy merging is supported (as appropriate
for gathering inventory), and is the required setting for all
FlexNet inventory agents managed under this system.

Manually configure settings packages for inventory agents.

Settings are determined automatically, based on behavioral
rules you create.

Manually deploy settings packages to managed devices.

Inventory agents (on inventoried devices) are updated
automatically.
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Inventory Manager 9.2

FlexNet Manager Suite 2015

Create multiple schedules for inventory agents and data
upload.

All FlexNet inventory agents share a single schedule for
local inventory gathering, and there is one schedule for
discovery across the network (but there are individual
schedules for importing inventory data from each third party
system, and for importing each kind of business data like
purchases).

Ability to run custom remote execution commands.

Only the specific remote execution tasks required for
inventory are available.

Manually identify target computers for adoption as managed
devices.

Option to automatically install an inventory agent on any
computers that are discovered (and do not already have an
agent installed). This rule-based 'adoption' can be targeted to
individual machines or to subnets.

By comparing product functionality with your requirements, you need to decide whether to:
•

Persist with Inventory Manager 9.2.3, using it as an inventory feed into FlexNet Manager Suite 2015, and not using
the FlexNet inventory gathering features in FlexNet Manager Suite 2015 at all. You are preserving Inventory Manager
functionality, shown in the left-hand column above, across your entire computing estate. This means you are done, and
take the Y exit from step 9 to leap forward to the finish line at step 16. (Otherwise you take the N exit and continue with
step 10.)

•

Switch entirely to the simplified native inventory gathering incorporated in FlexNet Manager Suite 2015, using the
new rule-based approach. You plan to enjoy the simplified management in the right-hand column above. There are two
alternative ways you can achieve this:

•

•

You can choose to switch your entire system in the shortest possible time (the Y exit from step 11). You do this simply
by exchanging your distribution server software for 2015 FlexNet Beacon software on each of the appropriate servers.
The new inventory beacons then automatically upgrade each managed device as it 'phones home' to ask for its latest
policy.

•

You can take a staged approach, where you carefully manage the switching of managed devices from 9.2 to 2015(the
N exit from step 11). For the period of transition in the migration project, you need to run both systems in parallel,
allowing for a managed transfer of devices from the old system to the new. In this case, continue with step 11.

Combine the systems, using distinct features of each in those parts of your enterprise for which they are best suited.
(Technically, this is like the switch-over scenario, except that you make the transition period of indeterminate length.) You
might, for example, use Inventory Manager to manage a set of machine-room servers for which you demand individual
scheduling and custom configurations of the inventory agent; whereas you might prefer the simplified management of
FlexNet Manager Suite 2015 for things like management or desktop and mobile devices. The current migration process
makes it practical to isolate parts of your present infrastructure for upgrade, and protect other parts to continue with the
old system. Nothing in the process sets a time limit on this kind of parallel operation. Of course, if you plan to extend this
parallel operation, you should consider the impact on other corporate processes, such as acquisition of new machines and
how these should be targeted for adoption by one system or the other. In the meantime, if considering parallel operation,
you should also continue with step 11.
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11. Upgrade agents on managed devices to 2015
Use your existing 9.2 Inventory Manager system to upgrade managed devices to the inventory agents supplied with FlexNet
Manager Suite 2015. A package is provided to assist with this.
•

If you are eventually migrating your entire estate away from Inventory Manager 9.2, you can upgrade managed devices
indiscriminately if you wish, since the new inventory agent is backward compatible with the 9.2 Inventory Manager
system, and continues to operate through the 9.2 distribution server hierarchy for the time being.

•

If you want parts of your estate (perhaps server rooms) to continue indefinitely under your 9.2 infrastructure, methods are
provided where you can exclude target machines from this upgrade. For example, you can use an existing security group
that identifies these machines (or create a Legacy security group) as an 'exclusion' from the upgrade process.

The upgrade package also updates the managed devices to recognize the inventory beacon(s) deployed with FlexNet Manager
Suite 2015, alongside their existing fail-over list of the old distribution server hierarchy. In migration mode, the inventory
beacons do nothing for unknown devices, and so each manage device calls the inventory beacon, gets nothing, and fails
over to its preferred 9.2 distribution server and continues normal operation in your existing infrastructure — until notified
otherwise!

Important • Managed devices upgraded to the 2015 inventory agent must first be switched into server-side policy merging.
Details: see Prepare Managed Device Self-Upgrade Package on page 33 and Distribute Self-Upgrade and Settings
Packages on page 36.

12. Swap distribution servers to inventory beacons
Include this step only if, at step 10, you choose to swap to the new system as quickly as possible.
The 'instant switch-over' approach relies absolutely on your replacing the distribution server software with FlexNet Beacon
software, on the same server, with the same IP address and DNS entry. This is because all your 9.2 managed devices have
a local record of the distribution server(s) they can access. If your migration process 'drops' a distribution server instead of
replacing it with an inventory beacon, all managed devices that can access only that distribution server are thereby orphaned.
You can only recover those orphans by visiting each one and manually upgrading and redirecting them. You avoid any nasty
surprises simply by doing an in place migration of each distribution server to an inventory beacon.
Once the inventory beacon is in place, as each managed devices calls for its latest policy, it is automatically updated to the
latest managed device software, and given the policy needed for the new FlexNet Manager Suite 2015 system. After a decent
interval to ensure that all managed devices (even the notebooks carried by road warriors) have been updated, you arrive at step
16.

13. Target managed devices for staged migration to the new system
You already have [at least some of] your inventory beacons rolled out, and the [selected] managed devices are ready to
connect with those inventory beacons. Now, in your web interface for FlexNet Manager Suite 2015, you create a rule for
a small target group of devices to manage through those inventory beacons. This group can be as small as one in the first
instance, until you satisfy yourself that everything works as expected. For details about targeting from the Inventory Manager
side, see Targeting the Inventory Agent Upgrades and Migration on page 37.
Each upgraded managed device, when it next 'phones home', tries to connect to an inventory beacon as top priority. As already
noted, in migration mode the inventory beacon rejects any devices that are not specified in its target, and those rejected
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devices fail over to the existing hierarchy of distribution servers, and continue operations under 9.2 as always. When the pilot
device(s) contact the inventory beacon, they are automatically issued a new policy that switches them out of the distribution
server hierarchy, and into the inventory beacon hierarchy. From the next scheduled inventory collection, these devices start
reporting their inventory directly to FlexNet Manager Suite 2015. For details of targeting from the FlexNet Manager Suite
side, see Create a Roll-out Target on page 66.
At this early stage, be very detailed in assessing the behavior of the pilot managed device(s). It is still possible to roll back to
the 9.2 system, but this becomes more time-consuming as more devices migrate. As a protection against accidental regression,
the system does not normally allow a device reporting through FlexNet Manager Suite 2015 to switch back to Inventory
Manager, and over-riding these safeguards required direct intervention.

14. Loop until done
You can continue to target pilot devices at any level you choose so that groups of managed devices are switched progressively
into the new system. If you were conservative about your rule targeting, you can continue to expand the targeting until it
includes all desired managed devices. When you are satisfied with progress, you can switch to operations mode, so that
any managed device attempting to contact the inventory beacon is now switched over. (Note that the devices in the Legacy
security group never come knocking on an inventory beacon, but continue operating as part of your Inventory Manager
infrastructure, unaffected by the changes.) There is a single check box that switches from migration mode into operations
mode, which automatically welcomes all remaining visiting devices into management by FlexNet Manager Suite 2015.

15. Decommission or re-purpose redundant Inventory Manager servers
When you are satisfied that all the managed devices previously reporting to a given distribution server have begun reporting
into FlexNet Manager Suite 2015, you can decommission that distribution server (by uninstalling the DS software). If
desirable, you might re-purpose this server hardware to become your next inventory beacon, rolling it into the migration
process back at step 8. Eventually, if you are not preserving any Inventory Manager 9.2 functionality, even your central
inventory server may be re-purposed.

16. Done!
Your new FlexNet Manager Suite 2015 system is fully operational, with (optionally) some parallel use of Inventory Manager
9.2.3 for specialized management of inventory agents with specialized schedules or custom configurations. A final topic
highlights a few manual clean-up actions (see Finishing Off on page 72).

Design the Final Topography
Whereas in release 9.2 or earlier, Inventory Manager and FlexNet Manager Platform (or earlier compliance product) might
be installed on a single server (and so thought of as 'combined'), it is important now that you approach migration thinking of
completely separate products. In particular, it is vital to mentally separate two ways of handling inventory:
•

FlexNet Manager Suite 2015 has its own direct inventory-gathering capacity (and may require a separate "inventory
server" to handle this); but as outlined in Process Overview on page 6, this is completely independent of the 9.2
Inventory Manager product.

•

You may also wish to continue operation of the 9.2 Inventory Manager solution as a separate inventory source for import
into FlexNet Manager Suite 2015 (always referred to a Inventory Manager in this document).
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At this stage of the design, the focus is entirely on the implementation of FlexNet Manager Suite 2015, independent of
Inventory Manager. So now to design your FlexNet Manager Suite 2015 implementation.
Determine whether to implement a single server or multi-server solution, based on projected scaling. Please refer to the
following diagram, where each blue box represents a potentially separate server, and where all are given the names referenced
throughout this document.

Note • Both the inventory server (processing server, or application server in a single-server implementation) and the
inventory beacon(s) are expected to be members of Active Directory domains. (For test environments, consultants may see
article 000017145 How to run FlexNet Manager Suite processing server on a workgroup computer.) Where you have only
a single batch server (also known as a reconciliation server), this is not required to be a member of an Active Directory
domain (although it may be). If you split this server into a master batch scheduling server and additional, separate batch
servers, the Microsoft messaging technology requires a common account which is much simpler to provide if all these servers
are members of the Active Directory domain. For this reason, domain membership is recommended, and assumed in this
document.
There are six different kinds of server functionality in FlexNet Manager Suite. Your implementation may merge all this
functionality onto a few servers; or for very large implementations, you may need six or more separate (virtual or physical)
servers. In all cases, it is important to understand the functionality of these separate components that make up a working
system:
•

At least one inventory beacon, and typically more for a complex infrastructure

Tip • When you are migrating from 9.2 or earlier, it is mandatory to install an inventory beacon on the batch scheduling
server (defined shortly). This inventory beacon (alone of all beacons) has access to the database, where migrated
connections are stored.
•

An inventory server, which can also be duplicated across multiple servers if you are gathering FlexNet inventory for many
tens of thousands of devices (see below)

•

A batch server (also known as a reconciliation server) that imports third-party inventory, integrates FlexNet inventory,
incorporates business-related information, and reconciles everything to calculate your license position

Note • Massive implementations may spread this load across multiple batch servers, in which case exactly one is the
'parent' or batch scheduling server that controls the load sharing. Here, 'massive implementations' means those with over
a million devices returning inventory, or with unusually high batch processing loads. Most likely you need only a single
reconciliation server here.
•

The database server (where the five underlying databases may also be split across separate database servers if required)

•

The web application server that handles presentation of the interface

•

A server for the business reporting option (powered by Cognos), where applicable. (This server may be shared between
FlexNet Manager Suite and FlexNet Manager for Engineering Applications.)
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Tip • Currently the Cognos content store requires a SQL Server installation no later than 2012.

Tip • If you previously had separate servers for FlexNet Manager Platform and Inventory Manager, you can start with your
FlexNet Manager Platform server and upgrade it to the new system, where it can function as any of the servers described
above (or indeed, for the combined servers as described next, if yours is a smaller implementation). Similarly, if you had a
separate database server in your previous implementation, that same database server may host the new databases shown in
the diagram.
All system servers require a 64-bit operating system. The database server (alone) may have a 32-bit operating system, but a
64-bit operating system is recommended.
In more moderately-sized implementations (the vast majority), a typical implementation might have a separate database
server and Cognos server, and combine the remaining three central functions as a single "application server", as shown
in the diagram. As scaling dictates, you can combine or separate the web application server, the batch server, and the
inventory server in any combination required. The logical separation of presentation from processing need not drive hardware
requirements. Scaling considerations may include the following:
•

Typically the first candidate for replication is the inventory beacon. This is often driven by network considerations as
much as by simple scaling considerations.

•

If your system manages more than 50,000 devices reporting FlexNet inventory alone (ignoring for the moment inventory
through other third-party tools), the inventory server should be separated onto its own device. You can expect to duplicate
a separate inventory server for (roughly) every 50,000 devices reporting FlexNet inventory.

•

If you manage inventory from more than 100,000 devices, the batch server (or reconciliation server) may be separated
from the web application server and installed separately.

•

If you manage in the order of a million inventory devices, the batch server itself may be split into multiple batch servers,
controlled by one batch scheduling server.
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Some of the inventory adapters (such as the XenApp adapter, ADDM adapter, and HPUD adapter) require a staging database.
This may be installed on any convenient SQL Server, with one of the options being your central database server hosting your
compliance database. Another option is to install the staging database on an appropriate inventory beacon. Decide on the
location of this staging database as part of your design.

Your previous combined server
If your previous implementation had FlexNet Manager Platform and Inventory Manager co-installed on the same server, you
should plan for this server to roll forward as your Inventory Manager 9.2.3 implementation. This path minimizes disruption.
Even when you are planning eventually to decommission Inventory Manager and rely entirely on the functionality in FlexNet
Manager Suite 2015, plan for this server to continue operations through the transition period.

Choose your web servers per device
Web protocols are used for data transfer within the FlexNet Manager Suite infrastructure. Two alternatives are supported, and
can be mixed and matched within the infrastructure of beacons and servers:
•

Microsoft IIS. Choose this alternative when any of the following apply:
•

The host server is one of your central application servers (web application server, batch server, or inventory server,
or combinations as applicable). No web server is required on a stand-alone database server. When you install the
recommended inventory beacon on the same device as the central batch scheduling server, that beacon also uses IIS
(whereas other free-standing beacons on separate devices still have a choice).

•

When a particular inventory beacon is collecting inventory from (and passing back recommendations to) FlexNet
Manager for SAP Applications, that inventory beacon must use IIS.

•

When you require Windows Authentication to allow transfer of data (for example, a parent inventory beacon might
typically use Windows Authentication if it receives data from a child in your DMZ outside a firewall).

•

When you require the use of the HTTPS protocol to encrypt data transfers.
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•

FlexNet self-hosted web server. Choose this alternative when none of the previous cases apply, and:
•

You want simple administration of the web server.

•

You want to minimize the installations on your inventory beacon, so that you do not need to install Microsoft IIS.

•

Anonymous access, and use of the HTTP protocol, are adequate (for example, within your secure LAN).

Output
Prepare a block diagram of the actual servers for your implementation. Start with the central collection of servers, depending
on the scale of your implementation.
Don't forget the inventory beacons you intend to deploy. You should include an inventory beacon on your batch server (or
processing server, or application server, depending on your scaling decisions), as this is a requirement to carry forward
management of connection strings that were set up previously on your old Inventory Manager system. Thereafter you may
choose to deploy a hierarchy of inventory beacons (perhaps mirroring your hierarchy of distribution servers used in your old
system), ensuring that every targeted device will have access (preferably high-speed LAN access) to an inventory beacon. One
or more of these inventory beacons may be used for 'bootstrapping' your managed devices that attempt to switch over to the
new system.
Label each block in your diagram with:
•

The server type, either 'inventory beacon' or as named in the diagram above (for ease of reference in following
instructions)

•

The actual server name and IP address

•

Which web server will be installed on each of these hosts

•

For inventory beacons, whether they will be used for bootstrapping.

Tip • The DNS name and IP address of the inventory beacons used for bootstrapping must be known in advance of the
inventory beacons themselves being deployed in the processes that follow.
Add to this diagram the additional server(s) being rolled forward for Inventory Manager 9.2.3 (either in the transition period,
or longer term).
Additional details will be added later.

Prerequisites and Preparations
Please ensure that you have worked through every one of the following topics.

Locate License Details
A license file for your existing product(s) was sent to you with your original order confirmation. (While you are under a
maintenance agreement, this same license entitles you to this system upgrade.) You will require your license file when you
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start from a single server combining Inventory Manager with FlexNet Manager Platform (or its predecessor Compliance
Manager), and migrating to a multi-server implementation.

Important • If you are updating from Inventory Manager 9.0 or earlier to Inventory Manager 9.2.3 as part of this overall
upgrade process, you must obtain a new license file, as the format of the licence file changed between these releases. You will
also require a new license file if you are purchasing additional options, such as FlexNet Manager for VMware.
In all other cases, locate your license file(s), originally despatched with your order confirmation.
If you cannot locate the license file, please contact the Flexera Software order processing team, and ask for a new copy of your
license file.

Identify (or Set Up) Accounts
In Active Directory, set up (or choose) the following accounts. At least three separate accounts are recommended as best
practice:
1. It is assumed that an existing database administrator (DBA) account will be used to set up and configure the databases as
described below.
2. An administrator account (say, FNMS-Admin, or an existing administrator account) with full admin access to all servers
used for the implementation (including inventory beacons). Account details must be passed to the DBA.
3. A network service account (say, SVC-fnmsservice) that will run the batch services and web services in normal
operations.
•

Admin access for this account is convenient; otherwise read, write, and execute permissions are required on all folders
containing FlexNet installations, FlexNet data, and FlexNet log files.

•

This account must have permission to log on as a service and as a batch job on the batch scheduling server (for details,
see Authorize the Service Account on page 49).

•

The process below also includes setting up database permissions for this account, so account details are needed by the
DBA.

Important • In a multi-server implementation, the same service account must be used on the web application server, the
inventory server(s), and the batch scheduling server (and where used, its child batch servers). This is required for proper
functioning of Microsoft Message Queueing between the servers.

Note • At implementation time, all services are configured with the correct password using the PowerShell scripts
provided. If at any time the password on the service account is forced to change, the services will cease to operate. To
ensure service continuity, you may either (a) allow the service account password to never expire (as normal for Windows
service accounts), where permitted by your corporate policies; or (b) review the accounts listed in Password Maintenance
on page 76.
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4. If you are collecting inventory from Citrix XenDesktop, you need an account with permission to execute remote
PowerShell scripts on the XenDesktop server. (Typically this is an administrator account on the XenDesktop server. You
may wish to register the FNMS-Admin described in 2. above for this purpose. Alternatively, a distinct account may be
used, and must be registered in the password store on the applicable inventory beacon.)
5. Also for use with Citrix XenDesktop, you need to register (in the password store) a Citrix Readonly Administrator
account, used for collecting data from the XenDesktop environment.
6. If you are collecting inventory from Citrix XenApp, you need an account with read permissions on the file system, and
able to run a scheduled task, on the XenApp Delivery Controller. This account is required only on the XenApp Server
(Delivery Controller), and is not registered in the password store on the inventory beacon. For further requirements for this
account, refer to the FlexNet Manager Suite Help > Adapters Supplied by Default > XenApp Server Adapter > Setting Up
the XenApp Server Adapter > Installing the XenApp Server Agent.

Tip • If you will be setting up an inventory beacon outside your central domain (such as an Internet-facing beacon to collect
inventory from travelling laptops), consider creating an additional account that is recognized, but has minimal privileges,
within your central domain. This account manages the transfer of information between your inventory/application server and
the inventory beacon. It has only one requirement within the central domain: the ability to use the HTTP or HTTPS protocol
to transfer data to/from your central inventory (or application) server. The name and password for this account are entered
directly in the inventory beacon interface, along with the URI it will access.

Note • All accounts that will log in directly to (any part of) the application server to use FlexNet Manager Suite (excluding
access through the web interface) must have db_owner permissions on all its databases: compliance data, warehouse data,
snapshot data, and inventory data. A suggested method is to create either a local or Active Directory security group (such
as FNMSUsers) and add all such accounts to this group. Then you can, for example, set these permissions by opening each
database in Microsoft SQL Server Management Studio, and granting db_owner privileges to the security group. Accounts to
list in the security group minimally include:
•

The operational service account (suggested: SVC-fnmsservice)

•

The installing administrator account (suggested: FNMS-Admin)

•

Any operational account needing to log in to a central inventory beacon installed on your batch scheduling server
(remember that since the inventory beacon requires administrator privileges to run, this account is both a local
administrator on the batch scheduling server and a db_owner)

•

Any future back-up administrator accounts needed for the application server.

Isolate the System
You need to protect your data from operational changes during the upgrade.
Since your previous implementation receives inputs from operators and through scheduled tasks, all these should be blocked
before you migrate.
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1. Send out the notification (such as email), as required by your corporate processes, to alert operators that the system is
going down for maintenance.
2. Log in to the server as a system administrator.
3. Shut down Microsoft IIS as the most efficient way to prevent any operator from logging in, or any files from being
uploaded. Use your preferred method. For example, using the user interface on Windows Server 2008:
a) Click Start, right-click on Computer, and select Manage from the context menu.
The Server Manager dialog opens.
b) In the left-hand navigation bar, expand Roles > Web Servers (IIS), and select Internet Information Services.
The IIS page is displayed.
c) In the Actions panel on the right, select Stop.
A message like Attempting to stop... appears. Note that it can take some time before the service is stopped.
4. Shut down all related Windows Scheduled Tasks. For example:
a) Ensure that your Server Manager dialog is still open.
b) In the left-hand navigation bar, expand Configuration > Task Scheduler > Task Manager Platform, and select the
ManageSoft folder.
c) Select all of the relevant tasks in the list (click the first, shift+click the last), and in the Actions pane, in the Select
Item section, click Disable (or right-click the selection, and click Disable).
d) Close the dialog.

Check Database Collation Sequence
All databases for this system, including tempdb, require the correct collation sequence, both case insensitive and accent
sensitive.
This means that they should be installed on one or more database instances that have this as the default collation sequence. If
you are carrying forward the database instance that previously supported your 9.2 implementation, this already complies with
the appropriate collations sequence. For any new DB instance, use this process to check the collation sequence.
1. In SQL Server Management Studio, locate the database instance in the Object Explorer pane.
2. Right-click the database, and select Properties from the context menu.
3. On the database Properties dialog, select the General tab, and in the Maintenance section, check the current collation
sequence.
If the collation sequence ends with the codes _CI_AS, you may proceed with the installation. Otherwise discuss the
collation requirements with your database authorities.

Important • If you have not already backed up your database, do so now.

Configure .NET and IIS
ASP.NET needs patching, and IIS configuration must be modified for ASP.NET.
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Detailed steps depend on the operating system and installed software. You must repeat this process in turn on each of:
•

web application server

•

batch server(s)

•

inventory server

•

each free-standing inventory beacon (the inventory beacon installed on your central batch scheduling server is covered by
the configuration of the batch scheduling server).

Note • Inventory beacons have an additional requirement, that PowerShell is at least at version 3.0. Should you wish to
upgrade PowerShell to release 4.0, Microsoft also requires .NET 4.5 on the same server. Take both these matters into
account at the same time (see Upgrade PowerShell on Inventory Beacons on page 23 for more details).
(If your implementation combines multiple servers into a processing server, or into an application server, then complete the
task once per server.)

Tip • Mark off each server on your block diagram as this process is completed for that device.
1. If the server is running Microsoft Windows Server 2012:
a) Open Windows Programs and Features.
b) Search the list of applications for Microsoft .NET Framework 4.5 (or later). If it is present, you have completed this
procedure, and may skip to the next topic, Configure Internet Explorer on page 24.
c) Because Microsoft .NET Framework 4.5 (or later) is not present, follow steps under "To install IIS and
ASP.NET modules on Windows Server 2012 using the UI" in http://technet.microsoft.com/en-us/library/
hh831475.aspx#InstallIIS.
2. If your server is running Microsoft Windows Server 2008, the original installation was .NET 4, but it may have been
upgraded already to 4.5. To check:
a) Open Windows Programs and Features.
b) Search the list of applications for Microsoft .NET Framework, and determine whether it is release 4 or release 4.5 (or
later).
•

If it is 4.5 (or later), you have completed this procedure, and may skip to the next topic, Configure Internet
Explorer on page 24.

•

If it is 4.0, apply the patches listed in step 3 (following).

3. On all other operating systems, ensure that both of the following patches are applied:
•

Update 4.0.3 for Microsoft .NET Framework 4 Runtime Update (KB2600211), from http://www.microsoft.com/en-us/
download/details.aspx?id=29053

•

Update for Microsoft .NET Framework 4 on Windows XP, Windows Server 2003, Windows Vista, Windows
Server 2008, Windows 7, and Windows 2008 R2 - KB2836939, from http://www.microsoft.com/en-us/download/
details.aspx?id=39257
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4. If you are currently patching an inventory beacon (including one co-installed with your batch scheduling server) with the
previous two updates, also ensure that you have applied this third patch: Update for the .NET Framework 4, from http://
support.microsoft.com/kb/2468871, and downloadable from http://www.microsoft.com/en-us/download/details.aspx?
id=3556.

Tip • The installer for inventory beacons will not run until this patch has been applied on the beacon server running .NET
Framework 4. (As before, the patch is not required if the version of .NET Framework is 4.5 or later.)
5. Open a Command Line window on the current server (for example, Start > search for cmd > run cmd.exe).
6. Enter cd %SystemRoot%\Microsoft.NET\Framework\v4.0.30319 (this folder is available only after you
have correctly installed Microsoft .NET Framework 4.0).
7. Install ASP.NET (which also registers ASP.NET with IIS when present), for example with the platform-appropriate
commands:
For operating systems up to Windows Server 2008 R2, use:
aspnet_regiis.exe -ir -enable

For Windows Server 2012, use:
dism
dism
dism
dism
dism

/online
/online
/online
/online
/online

/enable-feature
/enable-feature
/enable-feature
/enable-feature
/enable-feature

/featurename:IIS-ApplicationDevelopment
/featurename:IIS-ISAPIFilter
/featurename:IIS-ISAPIExtensions
/featurename:IIS-NetFxExtensibility45
/featurename:IIS-ASPNET45

If the server you are now working on is a free-standing inventory beacon that uses the FlexNet self-hosted web server (and
not IIS), loop back now and restart this process for the next server on your list.
8. Exit to close the command line window.
If you are currently working on your web application server or your batch scheduling server, loop back now and restart
this process for the next server on your list. For your inventory server and any inventory beacon using IIS, continue and
disable WebDAV on these devices.
9. Open the IIS settings page. For example:
•

On Windows Server 2008 R2, open Server Manager (Start > Administrative Tools > Server Manager). In the
hierarchy (on the left), expand Roles, then Web Server (IIS), and select Internet Information Services (IIS)
Manager.

•

On Windows 7, navigate to Control Panel > System and Security > Administrative Tools, and double-click
Internet Information Services (IIS) Manager.

10. In the work pane that opens, expand Sites, and select Default Web Site.
11. In the Home pane for this site, in the IIS group, locate WebDAV Authoring Rules.

Tip • If it is not present, it is likely that WebDAV is not installed on this server, and your mission is complete.
12. Right-click the icon, and select Open Feature. A pane opens for WebDAV Authoring Rules.
13. On the right, in the Actions group, there is an option to enable or disable WebDAV.
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•

If the link currently says Enable WebDAV, do nothing, because your mission is complete.

•

If the link current says Disable WebDAV, click the link.

14. Click OK to close all applicable dialogs.
If this is not the last server on your list, loop back and restart this process on the next server.

Tip • There is additional configuration of IIS handled by PowerShell configuration scripts described later.

Upgrade PowerShell on Inventory Beacons
PowerShell is used both as part of the installation, and for operation of inventory beacons after installation.
The minimum requirement on inventory beacons is PowerShell 3.0.
You may choose to upgrade PowerShell to version 4.0, but be aware that this release has a prerequisite of .NET Framework
4.5. In summary, you may chose either of the following combinations:
•

.NET 4.0, with the three patches required for inventory beacons installed (as in Configure .NET and IIS on page 20),
and PowerShell 3.0

•

.NET 4.5 (which requires no patches), and PowerShell 4.0.

Use this procedure to check the version installed on your candidate computer before installing an inventory beacon.
1. Within Windows PowerShell, run $PSVersionTable.PSVersion.
This produces output similar to the following:
Major
----3

Minor
----0

Build
-----1

Revision
--------1

2. If the Major value is less than 3, download your chosen version and install it.
For example:
•

For PowerShell 3.0, see http://www.microsoft.com/en-au/download/details.aspx?id=34595; and after installation,
continue with the patches below.

•

For PowerShell 4.0, see http://technet.microsoft.com/en-au/library/hh857339.aspx. When this is installed, you have
completed this procedure, as patches are not required for .NET 4.5.

3. If this inventory beacon is running .NET version 4, ensure that these three patches are installed (you may have completed
this earlier, under Configure .NET and IIS on page 20):
•

Update 4.0.3 for Microsoft .NET Framework 4 Runtime Update (KB2600211), from http://www.microsoft.com/en-us/
download/details.aspx?id=29053

•

Update for Microsoft .NET Framework 4 on Windows XP, Windows Server 2003, Windows Vista, Windows
Server 2008, Windows 7, and Windows 2008 R2 - KB2836939, from http://www.microsoft.com/en-us/download/
details.aspx?id=39257
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•

Update for the .NET Framework 4, from http://support.microsoft.com/kb/2468871, and downloadable from http://
www.microsoft.com/en-us/download/details.aspx?id=3556.

Configure Internet Explorer
Microsoft Internet Explorer needs configuration.
Compatibility mode must be turned off (step 4 below). In addition, when Internet Explorer is used on a server-based operating
system to access FlexNet Manager Suite after setup is complete (for example, if you are testing from your central application
server, or an inventory beacon has a server operating system), its enhanced security provisions must be turned off on that
server, as follows. (Alternatively, use a different browser.)
1. On a server operating system, open Administrative Tools > Server Manager. (On a non-server Windows operating
system, skip forward to step 4.)
2. Ensure that the Server Manager (top) node is selected, and in the Security Information group, click the Configure IE
ESC link.
3. In the Internet Explorer Enhanced Security Configuration dialog, ensure that the Off radio button is selected for both
Administrators and Users.
4. Open Internet Explorer and press the Alt key to display the Menu bar.
5. Click Tools, then Compatibility View Settings.
6. Make sure Display all websites in Compatibility View and Display intranet sites in Compatibility View are both clear.
There are a number of other configuration requirements for whichever web browser you choose to use:
•

URLs to add to your trusted locations

•

Recognition of your central server as an Intranet site, and allowing automatic logon

•

Javascript must be enabled

•

Cookies must be enabled

•

Windows authentication must be enabled

•

Font download should be enabled for optimum usability of the site

•

Any company proxy servers must allow browsers to access to the web application server.

Details for each of these are included in the first topic in the online help, Configuring Your Web Browser, available after the
product is upgraded.

Drivers for Spreadsheet Imports
You need a driver update in the following conditions:
•

You will import data from spreadsheets (the export of data to spreadsheets is not relevant, and the import of data from
CSV [comma-separated values] file is also not relevant)

•

The spreadsheets will be Excel spreadsheets in .xslx format (the earlier .xsl format does not require the driver update;
but be aware that this older format limits each spreadsheet to about 65,000 records/rows)
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•

You are working on a batch server or the batch scheduling server (or processing server, or application server in a single
server implementation); or you are working on an inventory beacon that will perform these spreadsheet imports.

In these conditions, you must install a 32-bit version of Microsoft Access Database Engine on the server. The particular
release is not important: for example, Microsoft Access Database Engine 2010-32 is adequate. Drivers are supplied within the
Microsoft Access Database Engine.

Important • Only the 32-bit version is supported by the import mechanism, and this version is incompatible with the 64bit version of Microsoft Office products installed on the same machine. This means that, when you need imports in .xslx
format, 64-bit Office cannot be installed on the central batch scheduling server (or processing/application server), or on
applicable inventory beacons. This limitation only prevents co-installation of the two code bases on the same computer. It
does not affect which document types can be imported. For example, Office documents including spreadsheets prepared in 64bit Office running on other machines can successfully be imported.

Download the Materials
Collect the contents for your upgrade process.
Position yourself on a computer that is accessible from all the central servers you will implement, and preferably at least some
of your inventory beacons.
1. Login to the Product and License Center at https://flexerasoftware.flexnetoperations.com.

Tip • Use the account details you have as part of your maintenance agreement.
2. From the list of products, select FlexNet Manager Platform, and select the same again in the following page to
differentiate elements of the Suite, if applicable.
3. Click through the link for FlexNet Manager Suite 2015 to access the downloads.
4. Depending on your login account, a click-through license may appear. If so, review the terms, and click I Agree.
5. Download the release notes, and review the requirements for the Windows Server computer(s) on which you will install
FlexNet Manager Suite 2015.

Tip • Use your block diagram of the servers to note requirements, and check these off when you validate that the
machines are adequately provisioned. Resolve any issues with server provisioning before proceeding with the
implementation.
6. Download the following archives and save to a convenient (network-accessible) location on this computer (such as C:
\temp\FNMSUpgrade\). You may unzip all these archive here.
•

FlexNet Manager Suite 2015 Installer.zip

•

Database Migration to FNMS 2015.zip

•

Inventory Agent 92 Upgrades to 2015.zip
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7. If you are collecting inventory from Citrix XenApp, also download:
•

Tier 1 Adapter Tools.zip.

8. If your implementation design includes FlexNet Report Designer (powered by Cognos), also download:
•

Report Designer Package - Single Tenant (FlexNetManagerPlatformReportsAndDashboard.zip) required even if you already have Report Designer implemented with FlexNet Manager for Engineering Applications.

Tip • There are additional downloads required if you are also upgrading your Inventory Manager installation. These are
covered in Identify and Update Inventory Manager Server on page 28.
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Preparing Inventory Manager
Topics:
•

Identify and Update Inventory
Manager Server

•

Prepare Managed Device SelfUpgrade Package

•

Distribute Self-Upgrade and
Settings Packages

•

Targeting the Inventory Agent
Upgrades and Migration

•

Splitting a Shared Database

If you do not have any installation of Inventory Manager as part of your current
implementation (see the first topic following for ways of checking), you may skip ahead
to the following chapter, Upgrading FlexNet Manager Suite on page 42.
Otherwise, your Inventory Manager system (including the inventory agents installed on
managed devices throughout your enterprise) can be prepared for the migration even
before FlexNet Manager Suite 2015 is installed. Work through the following topics.

Preparing Inventory Manager

Identify and Update Inventory Manager Server
This process corresponds to steps 2 through 5 in the overall flowchart in Process Overview on page 6. Complete all the
following on the central server(s) of your current implementation.
1. If you have not already done so, back up your server(s) now.
2. If you have been using FlexNet Report Designer (powered by Cognos) and intend to continue using it with FlexNet
Manager Suite 2015:
a) On your application server (where Inventory Manager runs), open regedit.
b) Navigate to HKLM\SOFTWARE\ManageSoft Corp\Compliance\CurrentVersion\BIDispatchUrl.
c) Take a note of the URL recorded there. You will use it when importing the updated reports package.
d) Close regedit.
3. Open your existing compliance product in the MMC console.
4. Look for the following nodes in the left-hand console tree:
•

Managed Device Settings

•

Discovery and Adoption

•

Remote Task Manager.

If any of these nodes is present, Inventory Manager is co-installed on the same server as your compliance product. This
server will roll forward as your Inventory Manager (only) server, at least for the time being. Check that your server plan
includes a new server (or set of servers) for FlexNet Manager Suite 2015. Also make a note that you must clean your
previous compliance product off this server, as described in the process below. This co-location also means that your
two products were using a shared database. Make a note that you need the process for splitting this database, described in
Splitting a Shared Database on page 40. For now, skip to step 6.
5. If you have been managing inventory from computers collected through FlexNet inventory agents, there is an installation
of Inventory Manager on another server. Identify that server (if need be, asking operators how they have been accessing
the inventory). To determine whether your two separately-installed products were accessing a shared database:
a) Start the registry browser on each of these two servers (compliance and inventory).
b) Browse to the following registry keys:
•

For 64-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ManageSoft Corp
\ManageSoft\Reporter\CurrentVersion\DatabaseConnectionString

•

For 32-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\ManageSoft Corp\ManageSoft
\Reporter\CurrentVersion\DatabaseConnectionString

c) Compare the values of the Database and Server settings.
If these two values each match across both servers, your two products were using a shared database. Make a note that
you need the process for splitting this database, described in Splitting a Shared Database on page 40.
6. On the server with Inventory Manager installed, in the MMC interface for the product (or combined products), open the
Help menu, and select Help about Inventory Manager.
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If the release shown is 9.2.3, you are done with this procedure. Skip forward to Prepare Managed Device Self-Upgrade
Package on page 33.
If the release is shown as 9.2, Flexera Software recommends that you upgrade to release 9.2.3. This upgrade delivers
enhancements consistent with the FlexNet Manager Suite 2015 upgrade, which will be helpful while these products
co-exist (full details are available in the release notes for 9.2.3). Should you choose to do without those enhancements,
technically the 9.2 release is sufficient to move forward with the upgrade of FlexNet Manager Suite.
If the release is prior to (less than) 9.2, you should upgrade the Inventory Manager 9.2.3 as the foundation for moving
forward with the joint systems.
7. Using your login credentials for Flexera Software Product and Licensing Center, navigate to the product download
page for FlexNet Manager Platform 9.2.3: https://flexerasoftware.flexnetoperations.com/control/inst/download?
element=5631471.
a) Log in to https://flexerasoftware.flexnetoperations.com.
b) Click FlexNet Manager Platform.
c) Click FlexNet Manager Platform again on the next page.
d) In the 9.2.3 row, click FlexNet Manager Platform again.
8. Download at least the following:
•

Release notes (FlexNet Manager Platform Release Notes.pdf)

•

For database migration: Database Migration Scripts 9.2.3 (Database Migration.zip)

•

For updates to the Inventory Manager software: Flexera Inventory Manager 9.2.3 Installer (im923.exe)

9. If you have not already done so, log on to the Inventory Manager server with a privileged account that:
•

Is a member of the domain where Inventory Manager and your database server are installed

•

Has Administrator privileges on your Inventory Manager server

•

Has Database Owner privileges.

10. Ensure that there is sufficient disk space on your database server to accommodate a complete copy of your existing
database.

Important • This is the space required for the database upgrade process. If you plan to use the same database server for
two products rolling forward, be aware that, in addition to separating the Inventory Manager and FlexNet Manager Suite
databases, the latter product also requires two or three additional databases:
•

Its own inventory database

•

FNMPSnapshot, used for performance improvement particularly relating to reports

•

FNMPDataWarehouse (this may have been present in the 9.2 implementation, where it was an option; but in 2015 it
is a requirement).

11. If you have not already done so, back up your database (see your SQL Server documentation for procedures).
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12. Ensure that all operators are logged out of Inventory Manager and your compliance product (such as FlexNet Manager
Platform).
13. Unzip the Database Migration.zip archive to a convenient working location on the Inventory Manager server
(such as C:\temp\IMUpdate).
14. Open a Command Prompt window, and navigate to your working copy of the migration folder (such as C:\Temp
\IMUpdate\Database Migration\Inventory Manager).
15. Run the mgsDatabaseUpdate.exe program, using the following syntax:
mgsDatabaseUpdate.exe -i InventoryManager.xml -nsu -l <logFile>
[-s <serverName>[\<instanceName>]] [-d <databaseName>] [-u <userName>] [-p <password>]

where:
-d <databaseName>

The name of the database to connect to. If -d is not specified, ManageSoft is
used.

-i InventoryManager.xml

This is the configuration file describing the migration tasks, and is of course
mandatory.

-l <logFile>

Identifies the path and name of the file to receive a log of the migration
tasks that occurred. If this option is not specified, a log file called
InventoryManager.log is created in the same folder where the
executable is running.

-nsu

Run the database update without putting the database into single user mode.
(The steps to perform migration require that multiple connections are made.)

-p <password>

The password for the username specified with -u. This is only required if the
database server is configured to use SQL Server authentication.

The name of the database server to connect to. If -s is not specified,
-s <serverName>
the value at HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node
or
\ManageSoft Corp\ManageSoft \Reporter\CurrentVersion
-s
<serverName>\<instanceName> \DatabaseConnectionString is used. The registry key is present on
the compliance and inventory servers. (If you have chosen to run this script
on the database server itself, the registry entry is not available, and you must
therefore specify the server name, or use the dot notation [.] to refer to the
current server.)
If the database is in a named instance (and not in the default database on the
server), the instance name must be specified as well.
-u <userName>

The username with which to connect to the database. This is only required if the
database server is configured to use SQL Server authentication. If not specified,
Windows Integrated Authentication is used to connect to the database server
using the current user’s credentials.

The following command performs the migration using the standard configuration file. Instead of recording the log in the
default log file, it will be written to the mig.log file specified in the command. Because the upgrade is running from the

Flexera Software "Company Confidential"

Migrating to FlexNet Manager Suite 2015 On Premises

30

Preparing Inventory Manager

inventory server, the database server name (and, if required, instance name) is retrieved from the registry, and Windows
Authentication is used to log in as the account name running the executable.
mgsDatabaseUpdate.exe -i InventoryManager.xml -nsu -l mig.log

Check messages on the command line to confirm that the database migration was successful. If any error messages occur,
check the log file to troubleshoot the problem. Do not proceed to the next step until the database migration is successful.
16. Optionally, re-index the database. Consider the following factors:
•

Re-indexing increases data access speed and recovers wasted disk space.

•

On large databases, this process can take more than 24 hours. You can proceed with the rest of your upgrade and
perform this step at a later, convenient time if required.

Tip • It is a good idea to re-index your database at least once a year. In SQL Server, tables that do not have clustered
indexes do not automatically reclaim space from deleted records. Re-indexing will reclaim this space.
If you decide to re-index at this time:
a) Start SQL Server Management Studio.
b) Open ReIndexAll.sql ( File > Open... and browse to Database Migration\Inventory Manager in the
unzipped archive, and select the file).
c) Click the Execute Query tool, or press F5 to run the script.

Tip • Reindexing is especially important if you have a lot of records in the Installation and
InstallationHistory tables.
17. Still logged in on the inventory server, ensure that:
•

All processes have completed—open the Windows Task Manager to check. If ndrplag.exe is still processing
tasks, allow it to finish.

•

The system is in a stable state (one that will not be modified by processing imports or the like).

•

The administration console (MMC interface) is closed.

18. If this is a co-located installation of Inventory Manager and your compliance product on the same server, keep the former,
and remove the latter as follows:

Tip • It is a requirement that you remove the co-located compliance product before updating Inventory Manager.
a) On the application server, open Program and Features (Control Panel > Uninstall a Program).
b) Uninstall FlexNet Manager Platform (or your earlier compliance product, such as Compliance Manager), and then
close Program and Features.
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c) Use Windows Task Scheduler to remove the scheduled task called Execute business importer
connections.
19. Navigate to where you downloaded the Flexera Inventory Manager 9.2.3 Installer (im923.exe), and double-click the
executable.
A setup page for Flexera Inventory Manager appears.
20. In the menu bar, click Install.
The Install menu is displayed.
21. Under the Inventory Server heading, select Install.
The installation wizard is invoked, and checks your system for prerequisites, as well as for content that must not be
present. Depending on the results of these tests, you may be asked to perform various functions before you can progress
with the installation. When the checks are satisfactorily completed, the wizard displays its welcome page.
22. Step through the installation wizard.

Tip • If you prefer step-by-step guidance through the wizard, open UpgradeGuide.pdf from the documentation folder of
your existing Inventory Manager installation, and in chapter 3, Upgrading administration servers, find the process To
upgrade an administration server. Detailed documentation of the wizard starts from step 4 of this process.
23. When installation wizard is complete, enable the following scheduled tasks (steps described below):
•

Generate ManageSoft system status information

•

Generate ManageSoft Wake on LAN jobs

•

Import ManageSoft application usage logs

•

Import ManageSoft discovery information

•

Import ManageSoft distribution logs

•

Import ManageSoft installation logs

•

Import ManageSoft inventories

•

Import ManageSoft remote task status information

•

Import ManageSoft system status information

•

Merge ManageSoft policies

•

Process ManageSoft remote execution actions.

Three other Inventory Manager schedules are created:
•

Process ManageSoft distribution jobs —This task is always ‘Running’ and does not need to be
enabled.

•

Reconcile ManageSoft directory tables with AD —This task is disabled by default. If you do want
to enable this task, ensure that its timing will not clash with the Merge ManageSoft policies task as it also performs
reconciliation.
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•

Service the ManageSoft database —This task is disabled by default, but can be manually enabled or run
if and as appropriate for your environment.

To enable the scheduled tasks in the list above:
a) Navigate to Scheduled Tasks (for example, Start > Settings > Control Panel).
b) For each of the scheduled tasks listed above, right-click the task and select Properties.
c) Select the Enabled (scheduled task runs at specified time) check box.
d) Click OK, and repeat for the remaining scheduled tasks in the list.
24. Decide when to upgrade some of your distribution servers, and which ones to target for removal:
•

There is no urgency: the upgraded central Inventory Manager server is backward-compatible with earlier distribution
servers.

•

Some of your distribution servers may shortly face decommissioning, or re-purposing as inventory beacons. There is
no value in upgrading these.

•

For the time being, use the distribution server hierarchy recorded in Inventory Manager to identify all distribution
servers and their specific purposes (such as "desktop inventory", "machine room inventory", "Oracle introspection",
and the like). From the list, identify the ones that can be targeted for removal as their managed devices are switched
over to FlexNet Manager Suite 2015.

•

When you decide to migrate any distribution servers, use the previous UpgradeGuide.pdf, chapter 4, Upgrading
distribution servers, to guide you.

Prepare Managed Device Self-Upgrade Package
You have identified the managed devices in your estate that are to migrate to exclusive management using FlexNet Manager
Suite 2015.

Important • Managed devices migrating to 2015 must be covered by server-side policy merging. Any managed devices for
which client-side policy merging remains important must not be migrated, and must continue under Inventory Manager 9.2.
The switch to server-side policy merging is incorporated in the self-upgrade package provided.
You have further identified how to target these devices, whether by operating system, security group, or other techniques.
You also have ready your block diagram of all servers, including inventory beacons and which of these will be used for
bootstrapping managed devices into the new system (see Design the Final Topography on page 13). And you have completed
the upgrade of your central Inventory Manager Server to 9.2 SP3 (or thereabouts).

Warning • You must NOT upgrade the managed devices until after your central server has been upgraded.
Now prepare the self-upgrade package for the target managed devices.
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Tip • This procedure covers Windows-based managed devices. For non-Windows managed devices, see your previous
UpgradeGuide.pdf from the documentation folder of your existing Inventory Manager installation, and refer to chapter 5.
This procedure corresponds to step 11 in the flow-chart in Process Overview on page 6.
1. Copy Inventory Agent 92 Upgrades to 2015.zip to this server, and unzip to a convenient location (such as
C:\Temp).
You downloaded this archive in the process under Download the Materials on page 25.
2. If your migration of Inventory Manager has not taken you all the way to 9.2 SP3, locate the files linuxdpkg and
linuxrpm from the unzipped archive, and copy them to warehouse-folder\Repository\Environments (the
default value for warehouse-folder is C:\ManageSoft).
3. Open a Command Prompt and navigate to install-dir\Common.
Replace install-dir with the installation directory for Inventory Manager 9.2 SP3.
4. Execute the following command:
mgsreceive.exe -N extracted-archive-folder\Flexera -d Flexera -o pack=FALSE

where extracted-archive-folder is the folder (such as C:\Temp) where you unzipped the upgrade packages. This loads the
upgrade and settings packages into your 9.2 software library, visible in the MMC.
5. Open your upgraded Inventory Manager.
We must customize the settings package before distribution and targeting.
6. Under the Flexera Software node, expand the Software Library node, and continue expanding it (Flexera > FNMS
2015 Migration Settings > 10.2.0 > Rev 1.0 ) until the FNMS 2015 Migration Settings project is visible. Right-click the
package and select Edit....
7. In the navigation bar, expand Registry Entries > All Registry Entries > HKEY_LOCAL_MACHINE > SOFTWARE >
ManageSoft Corp > ManageSoft > Common > DownloadSettings > InventoryBeacon node.
8. In the right-hand pane, double-click the Host entry.
The Host Properties dialog appears.
9. In the Value field, enter the fully qualified domain name of an inventory beacon in your FlexNet Manager Suite 2015
system that will be used for bootstrapping managed devices across to the new system.
You identified the inventory beacon(s) for bootstrapping as part of your design work in Design the Final Topography on
page 13.

Note • If you are not using HTTP protocol on the standard port 80, you may also modify the following settings in your
package:
Location

Notes

Port

The default value for HTTP protocol is 80, and the default for HTTPS protocol is 443. If
necessary, edit the port value to match the configuration of this inventory beacon.
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Location

Notes

Protocol

Either accept the default value of http, or you may edit it if you are using the HTTPS
protocol on this inventory beacon. (The value is case insensitive.)

If you wish, you may also identify multiple inventory beacons for bootstrapping managed devices into the upgraded
system by defining additional DownloadSettings. For example, if your NetSelector algorithms include
MgsSubnetMatch, you may wish to include an inventory beacon in each of your subnets for maximum network
efficiency in inventory uploads from the managed devices. You can identify all such inventory beacons here: each
managed device will choose the one within its own subnet (or the one that gets top priority according to your selected
algorithms).
10. In the navigation bar, expand Registry Entries > All Registry Entries > HKEY_LOCAL_MACHINE > SOFTWARE >
ManageSoft Corp > ManageSoft > NetSelector > CurrentVersion node.
11. In the right-hand pane, double-click the SelectorAlgorithm entry.
The Selector Algorithm Properties dialog appears.
12. In the Value field, replace $(ExistingSelectorAlgorithm);MgsInventoryBeaconMatch with your current
choices of net selector algorithms with the new MgsInventoryBeaconMatch value appended on the end.
On targeted managed devices, the settings package also modifies the PolicySource registry value to the value
Server. Only server-side policy management is supported in 2015.
13. Click OK on the properties dialog, and click Save on the project.
14. Optionally, customize setup.ini.
Use this file to add transforms to the installation of the managed device, suppress installation of the application usage
agent, or prevent users cancelling the upgrade process on their computer (managed device). For details, see Configure
setup.ini on page 35.
Your self-upgrade package and settings package are now ready to distribute to your distribution servers. Even though FlexNet
Manager Suite 2015 is not yet in place, you may distribute the packages now, as we have a separate step to apply these
packages; and even thereafter, the managed devices will update, and fail over to their current fail-over locations until they are
targeted by an inventory beacon in the new system. Distributing (and optionally applying) the packages now gives time for
the upgrade and settings to percolate through your managed devices while you are completing the next stages of the central
upgrade. Or, if you prefer, distribute the packages later, if that better suits your processes. Whenever you are ready, you'll find
details in Distribute Self-Upgrade and Settings Packages on page 36.

Configure setup.ini
This file modifies the installation of the managed device.
Use this optional procedure if you wish to:
•

Control the level of end-user feedback and control for the managed device upgrade

•

Add a transform to the MSI package

•

Switch off the installation of the application usage agent.

Each of these options is independent.
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Tip • Be aware that there are two .ini files available. This is the one for the MSI, and is called just setup.ini (not
mgssetup.ini).
1. On your 9.2 Inventory Manager application server, in the flat text editor of your choice, open C:\ManageSoft
\Repository\Packages\Flexera\Upgrade for managed devices\10.2.0\Rev 1.0\Upgrade
for managed devices\setup.ini.
2. Within the setup.ini file, locate the section [Startup].
3. To prevent users from manually cancelling the managed device upgrade, under that heading enter
UserInteractionLevel=/q

This quiet-mode setting suppressed the default user interface (which includes a Cancel button) during the upgrade.
4. To prevent installation of the application usage agent, in the same section of the file, locate CmdLine and append:
REMOVE=aua

5. To attach your transform files to the MSI, to the same CmdLine, append a list of your transform files, separating
multiples with semi-colons(;), as in the following example:
Transforms=custom1.mst;custom2.mst

6. Save and close the file.
Your modified setup.ini is automatically included in the upgrade package to be distributed shortly.

Distribute Self-Upgrade and Settings Packages
You have prepared, validated and (preferably) tested your self-update and settings packages for managed devices that are
to migrate out of Inventory Manager control and into management through FlexNet Manager Suite 2015. You now wish to
distribute these packages to distribution servers accessible to those selected devices. In fact, the first level of targeting that
may be applicable in your enterprise is to restrict the packages to certain distribution servers. For example, suppose that one
distribution server exclusively manages inventory from a machine room, and you wish to preserve this machine room under
Inventory Manager control. You should exclude that distribution server from the list that receive the upgrade package.

Tip • The upgrade package causes managed devices to self-update to 2015 inventory clients. These clients are compatible
with both the 2015 system and the previous 9.2 Inventory Manager system. You may like to send this package to all your
managed devices to get the latest client functionality. The switch from 9.2 to 2015 is controlled exclusively by the settings
package. Therefore, when targeting managed devices to migrate, include the settings package; and when deciding on
managed devices that should remain in the 9.2 system, exclude the settings package from these devices.
This procedure is part of step 11 in the flow-chart in Process Overview on page 6.
You can distribute the packages from the Software Library node of Inventory Manager. This will distribute the packages for
all managed device platforms:
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1. Right-click the Software Library node and select Distribute....
The Package Distribution Wizard page is displayed.
2. Click Next.
The Assign Packages page is displayed.
3. Select (by checking the boxes) Flexera\FNMS 2015 Migration Settings and Flexera\Upgrade for managed device
\10.2.0, and click Next.
The Select Distribution Locations page is displayed.
4. Select each of the servers to which you will distribute, and click Add.
5. If required, select the Force distribution option.
It is not compulsory to force distribution. This is used to overwrite packages on distribution locations, even if they are not
listed as needing the update. Use this option if you are not certain that your distribution database is an accurate reflection
of the state of your distribution servers.
6. Click Next.
The Distribution Priority page is displayed.
7. Select a priority for the package.
Normal is the default setting).
8. Click Next.
The Selection Summary window is displayed.
9. Click Next.
The Completing the Package Distribution Wizard page is displayed.
10. Click Finish.
The package(s) is/are now sent to the selected distribution servers.
11. After allowing adequate time for the distribution and reporting traffic, verify delivery by clicking on Reports >
Distribution > Packages > All.

Targeting the Inventory Agent Upgrades and
Migration
The update and settings packages are distributed. Now determine which devices should act on which of these packages.
This procedure corresponds with step 13 in Process Overview on page 6.
You are already familiar with targeting upgrades in your previous implementation, and with the options for policy-level
filtering or package-level filtering available in Inventory Manager 9.2. If your goal is that selected managed devices will
migrate to FlexNet Manager Suite 2015, and that another group of managed devices do not migrate but continue (at least for
the time being) under Inventory Manager 9.2, it is mandatory that you target the settings package only to those devices that
should migrate. (The inventory agent upgrade package is compatible with either system for both client-side policy merging
and server-side policy merging, and may be sent to all inventory clients if you so wish.)
This targeting in Inventory Manager creates a pool of managed devices primed for migration (because they are both upgraded,
and received the settings package). Later, on the FlexNet Manager Suite side, you can at first apply additional targeting to
this group to allow only a test device, or a pilot group of devices, from the pool to migrate. But in due course, as you move
out of the testing phase, that filtering is removed, and then every device in the migration pool will automatically switch over
to FlexNet Manager Suite 2015 and its hierarchy of inventory beacons. At that time, it is critical that the managed devices
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intended to continue under Inventory Manager 9.2 have not received the settings package, or they will be 'lost' by switching
over to the new system.
You may have already applied a first line of control by excluding certain distribution servers from even hosting the settings
package (see Distribute Self-Upgrade and Settings Packages on page 36).
Whether or not that is the case, you now need to exert further control, for which your options include policy-level filtering
and package-level filtering. Your enterprise has most likely fixed on one or other of these approaches to use. Both are applied
through the Add to Policy wizard in Inventory Manager. Below is a summary of the process, and more detail is available in
your 9.2 documentation (including the SoftwareDeploymentGuide.pdf chapter 3, Best practice for a discussion of
options, and chapter 5, Deployment policies for details of the wizard).

Tip • If none of your existing Active Directory security groups allow for the appropriate targeting of this upgrade, consider
creating purpose-specific security groups before starting this wizard. Two sample groups are discussed in the procedure
below: read ahead for details.

Note • If you are not using Active Directory and instead use ManageSoft policy, adapt the principles below for your
corporate practices. For example, you can first assign the upgrade package to your pilot policy, and after verification, assign
the same package to your production policy. Then, if you have some managed devices that you want to switch to the new
system, target those devices for the client settings package. Remember that only those devices that are both upgraded to the
2015 inventory client and have the updated client settings package can switch to the new system.
You may choose to do package targeting now, or later. If you do it now, the updated managed devices check for an inventory
beacon, and for as long as they do not succeed, fail over to their existing hierarchy of distribution servers. If you do it later,
you introduce a further delay while you wait for the update package and settings package to be applied. Doing it now allows
plenty of time for the managed devices to self-update and collect the new settings package while you work on other things.
The device upgrade package and the settings package must be targeted separately.
1. In Inventory Manager 9.2, navigate through the Software Library to select the upgrade package you have prepared and
distributed.
2. Either right-click the package in the console tree and select Add to Policy, or in the right-hand page click the Add this
package to policy action button.
The Add to Policy Wizard is displayed.
3. Click Next.
For the path described here, the Select Deployment Policy page is displayed. By choosing the appropriate policy, you are
using policy-level filtering. You need to be aware of where in the Active Directory hierarchy this policy is attached, as it
will be applied to all managed devices in this group and all its descendents. At this stage, keep in mind that the inventory
agent upgrade is applicable to all managed devices, if you so choose.
4. Expand the relevant domain and browse to the policy to which you want to assign your upgrade package. With the policy
selected, click Next.
The Create or Choose Group page is displayed.
5. Select one of the following radio buttons:
•

Create a new, empty filter group

Flexera Software "Company Confidential"

Migrating to FlexNet Manager Suite 2015 On Premises

38

Preparing Inventory Manager

Accept the default name proposed, or type a unique name that better reflects the group's purpose (such as
ManagedDeviceUpgrade). This is often a good option for providing highly customized targeting for your upgrade
package.

Note • After completing this wizard, you must add members to this new security group, either in the Group Policy
Object Editor, or using the Package Allocation wizard. Save effort at this stage by including in this security group
only those devices that you wish to upgrade to the latest inventory client, but to continue under management with
Inventory Manager 9.2. (We use a different security group for devices that are migrating to the new system, next time
through the wizard, as noted below.)
•

Select an existing filter group, applying the package to all group members
Use the Browse for Filter Group page to select the relevant container or security group, and select its check box
before clicking OK. Keep in mind that this adds your upgrade package to whatever other packages and policy the
members of this group receive.

•

Apply this package without filtering to all members of the selected policy
This allows pure policy-level filtering (by your choice of policy in the previous page), with no package-level filtering
applied.

6. Click Next.
The Package Applicability page is displayed.
7. Ensure that the default All users on targeted computers (computer policy) is selected, and click Next.

Note • Only computer policy is supported going forward. If you need any user policies, these policies and their users and
machines must be preserved for operation in Inventory Manager 9.2.
The Deployment Conditions page is displayed.
8. Accept the default (This application must be installed. (Mandatory)) and leave both Removal options unchecked. Click
Next.
The Postponement Options page is displayed.
9. Set the options to suit your corporate practices for allowing users to delay the update package, and click Next.
Since this update package only changes the behavior of the inventory agent and does not involve rebooting the device, it
may be quite acceptable to leave all options deselected so that the end-user may not delay your migration process.
The Package Lifetime Options page is displayed.
10. Accept the default As soon as policy becomes effective, and click Next.
The Summary page is displayed.
11. Review the details, and if everything is as intended, click Next.
The wizard creates a policy and (if required) security group as specified. This may take a few moments. Then the
Completing the Add to Policy Wizard page appears.
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Tip • If you created a new security group, there is a check box Begin allocating this software package to end-users or
computers displayed on the page. Leave this checked to start the Package Allocation wizard and target the individual
machines you want in the group. (For details about the Package Allocation wizard, see the section To allocation a
package to users or computers in chapter 5, Deployment policies, of the SoftwareDeploymentGuide.pdf.)
12. Click Finish to complete this wizard.
13. Repeat from step 1 for the settings package, being careful to target this package exclusively to those managed devices
which you intend to migrate to the new system. Use a separate security group as noted here:

Note • The second time through the wizard, create a second security group such as MigrateTo2014R3.
•

Later, in group policy, insert as members of this group all the managed devices that you want to migrate to the new
system. This means that they receive the settings package.

•

Also in group policy, make the group MigrateTo2014R3 also a member of the earlier group
ManagedDeviceUpgrade. This means that the migrate targets also receive the device upgrade package.

14. To monitor progress on self-updating of the managed devices:
a) Select the Reporting node.
b) In the right-hand details panel, locate the Package Installation table.
c) Locate the Managed Devices group, and select the link for All.
All information on distributed packages is displayed.
d) Locate the required package in the list, and click the graph icon to its left. Use the dynamically-updated graph to track
the distribution and installation of the self-update package.
Once the next policy merge is run, the updated policy is applied to the target groups. Managed devices in those groups will
self-update, and wait for an inventory beacon to be available to them.

Splitting a Shared Database
The migration process requires separate databases because of schema incompatibility from Inventory Manager to FlexNet
Manager Suite 2015.
In Identify and Update Inventory Manager Server on page 28, you clarified whether you previous implementations of
Inventory Manager and your compliance product shared a common database. If that was NOT the case, so that they already
had separate databases, skip this topic.
The previous, shared database will roll forward as your Inventory Manager database (at least for the time being). In this
process you will split off a copy to convert into the FlexNet Manager Suite 2015 database, and clean up both databases
following the separation.
As already noted, your new database can share the same server, subject to software version and adequate disk space (and
remembering the additional databases required for the new release). In Design the Final Topography on page 13, you
identified (and recorded) your database server for FlexNet Manager Suite 2015.
This procedure corresponds to step 5 in Process Overview on page 6.
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1. Backup the existing shared database (its default name was ManageSoft).
For details about backing up, see http://msdn.microsoft.com/en-us/library/ms187510(v=sql.100).aspx. (This is in addition
to the protective backup at the start of the entire process. This time you are backing up the updated database.)
2. Did your previous implementation include the data warehouse database (then used for reports prepared in FlexNet Report
Designer)? If so:
a) Also back up this database (its default name was FNMPDataWarehouse).
b) Copy this database to the SQL Server database identified for the data warehouse database in your server plan.
Upgrade of this relocated database follows in Upgrade/Create Databases on page 43.
3. Use the previously-shared (ManageSoft) backup file you just created, and restore it on the SQL Server database
identified for FlexNet Manager Suite 2015 in your server plan. The default database name (used in this document) is
FNMP.
For details about restoring, see http://msdn.microsoft.com/en-us/library/ms177429(v=sql.100).aspx. You will resume
working on this database in Upgrade/Create Databases on page 43.
4. Using SQL Management Studio:
a) Connect to the SQL database server where your current Inventory Manager database is located (the default name was
ManageSoft), and select that database.
b) Choose File > Open, navigate in the database migration folder in your downloaded archive (such as C:\Temp
\FNMSUpdate\Database Migration\FlexNet Manager Platform\Normal), and open
IM92SchemaCleanup.sql.
c) Execute this SQL script on the ManageSoft database (or equivalent if you renamed this).
This script removes tables, views, and functions that are related only to FlexNet Manager Suite, and not needed for the
continued operation of Inventory Manager.
You have now separated your previously combined databases, such that the previous one (default name ManageSoft) carries
forward for Inventory Manager data only, and the new copy (default name FNMP) is used for FlexNet Manager Suite 2015.
If, as well as the shared database, your previous implementation also had your compliance product (Compliance Manager or
FlexNet Manager Platform) and Inventory Manager installed on the same server, you also need to remove the compliance
product from this server, allowing it to roll forward as your Inventory Manager server.
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Upgrading FlexNet Manager Suite
Topics:
•

Upgrade/Create Databases

•

Authorize the Service Account

•

Install the Web Interface

•

Install the Inventory Server

•

Install the Batch Processors

•

Configure the System

•

(Re-)Activate the Product

•

Populate the Downloadable
Libraries

•

Import the Sample Reporting
Package

•

Configure Web Browsers

•

Link to Flexera Service Gateway

•

Update Access Rights

•

Deploying Inventory Beacons in
Migration Mode

•

Migrating Citrix Inventory
Collection

•

Finishing Off

You have completed all the prerequisites in Prerequisites and Preparations on page 17
(and its subsections). Depending on your starting conditions, you have also separated any
previously combined databases and cleaned up any co-installation of FlexNet Manager
Platform (or Compliance Manager) from what is now your Inventory Manager server.
Only when all these tasks are complete should you move forward to the upgrade of
FlexNet Manager Suite to 2015.
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Upgrade/Create Databases
Any existing compliance databases must be upgraded, and 2015 uses additional mandatory databases.

Tip • Previously you have been working on Inventory Manager preparations. Now clear your mind of anything to do with
Inventory Manager. Keep in mind that FlexNet Manager Suite 2015 also separately manages its own inventory information
in its own inventory database. In this procedure, we are concerned solely with the databases for FlexNet Manager Suite
2015, including its own inventory database. (Later, we will configure Inventory Manager to be a data source feeding into the
FlexNet Manager Suite inventory database.)
Before you start, decide whether to include FlexNet inventory data in the same operations database as compliance information
(suitable for small implementations). If so, use the same database name for the -d parameter in steps 5 and 8 below. As
written below, these steps suggest different database names and separate these two databases. (With previous releases, it was
recommended and common practice to install a single database combining inventory and compliance data. With FlexNet
Manager Suite 2015, it is now generally recommended to install these as separate databases, and particularly so if you manage
FlexNet inventory from 20,000 devices or more.)

Important • If you choose to combine inventory and compliance data in a single operations database, you MUST create the
databases in the order shown below: first the compliance operations database, and then add the inventory collection database
to it.
Take note of all the database names you create with the -d parameter in the following steps. You need the names later (if
database setup is done by a separate DBA, the database names must be handed off to the installing administrator).

Note • All accounts that will log in directly to (any part of) the application server to use FlexNet Manager Suite (excluding
access through the web interface) must have db_owner permissions on all its databases: compliance data, warehouse data,
snapshot data, and inventory data. A suggested method is to create either a local or Active Directory security group (such
as FNMSUsers) and add all such accounts to this group. Then you can, for example, set these permissions by opening each
database in Microsoft SQL Server Management Studio, and granting db_owner privileges to the security group. Accounts to
list in the security group minimally include:
•

The operational service account (suggested: SVC-fnmsservice)

•

The installing administrator account (suggested: FNMS-Admin)

•

Any operational account needing to log in to a central inventory beacon installed on your batch scheduling server
(remember that since the inventory beacon requires administrator privileges to run, this account is both a local
administrator on the batch scheduling server and a db_owner)

•

Any future back-up administrator accounts needed for the application server.

Flexera Software "Company Confidential"

Migrating to FlexNet Manager Suite 2015 On Premises

43

Upgrading FlexNet Manager Suite

Tip • Because you are migrating content from a previous 9.2 implementation (or earlier), it is mandatory that you install an
inventory beacon on the batch scheduling server component of your FlexNet Manager Suite central servers. The account that
will access that central batch scheduling server also needs to be included in this security group. For more about inventory
beacons, see Deploy Inventory Beacons on page 64.
This procedure assumes that you are updating a previous database from 9.2. This may either be one that was always separate,
or one that you split in the procedure Splitting a Shared Database on page 40.
1. Create a security group (suggested: FNMSUsers), and (optionally) add to it all accounts directly logging into the central
application server (or you can add accounts later).
2. Use SQL Server Management Studio to ensure that the database Recovery model is set to Simple (first recording its
current value before changing it if necessary).
Especially for large databases, this prevents the transaction log from growing to excessive proportions. Because of this
growth, for databases of all sizes, the migration process will truncate the transaction log at the end of the process, and this
truncation relies on the simple Recovery model. If the model is not currently Simple, note the existing value — there is
a reminder below to restore this value after a successful database migration.
3. Back up any customized files to a temporary location, (for example, C:\temp).
Customized files may include compliance importer procedures (XML files located by default in
installation_dir\Compliance\ImportProcedures from 8.0 onwards, or for earlier releases, check in
sourceprocedures.xml).
4. Ensure that the target database instance is set for case-insensitive and accent-sensitive collations (as required by all
databases in this system, including the tempdb). To check the collation settings:
a) In SQL Server Management Studio, locate the database instance in the Object Explorer pane.
b) Right-click the database, and select Properties from the context menu.
c) On the database Properties dialog, select the General tab, and in the Maintenance section, check the current
collation sequence.
If the collation sequence ends with the codes _CI_AS, you may proceed with the installation. Otherwise discuss the
collation requirements with your database authorities.
5. Ensure that you have sufficient disk space on the database server for a complete second copy of your database during
migration.

Tip • When considering disk space, keep in mind that FlexNet Manager Suite 2015 requires two or three additional
databases, all of which are mandatory:
•

Its own inventory database

•

FNMPSnapshot, used for performance improvement particularly relating to reports

•

FNMPDataWarehouse (this may have been present in the 9.2 implementation, where it was an option; but in 2015 it
is a requirement).

6. If you have not already done so, log on to the central application server with a privileged account that:
•

Is a member of the domain where FlexNet Manager Suite and your database server are installed
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•

Has administrator privileges on your central application server(s)

•

Has database administrator privileges. (As usual for DBAs, this account must also be in the built-in
SQLAgentUserRole, as the scripts also create an SQL job. If this is not already the case, the following command in
SQL Management Studio adds the account to the role.)
ALTER ROLE [SQLAgentUserRole] ADD MEMBER [accountName]

7. If you cannot access your downloaded and unzipped archives from your current login on this application server, copy
Database Migration to FNMS 2014 R3.zip to this server and unzip it to a convenient location, such as C:
\temp\FNMSUpgrade.
8. Open a Command Prompt window, and navigate to your working copy of the migration folder (such as C:\Temp
\FNMSUpdate\Database Migration\FlexNet Manager Platform\Normal).
9. Run the mgsDatabaseUpdate.exe program, using the following syntax:
mgsDatabaseUpdate.exe -i ComplianceMigration.xml -nsu -l <logFile>
[-s <serverName>[\<instanceName>]] [-d <databaseName>] [-u <userName>] [-p <password>]

where:
-d <databaseName>

The name of the database to connect to.

Note • If you are currently operating from a new application server that has
not previously connected to the database server, this parameter is mandatory.
A suggested name is FNMP. If you are upgrading an existing application
server that has separately run your compliance product (not in co-location
with Inventory Manager), the registry entry listed below for the -s option
is normally set. In this case, if you omit the -d option, the database name is
taken from the registry key.
-i ComplianceMigration.xml This is the configuration file describing the migration tasks, and is of course
mandatory.
-l <logFile>

Identifies the path and name of the file to receive a log of the migration
tasks that occurred. If this option is not specified, a log file called
ComplianceMigration.log is created in the same folder where the
executable is running.

-nsu

Run the database update without putting the database into single user mode.
(The steps to perform migration require that multiple connections are made.)

-p <password>

The password for the username specified with -u. This is only required if the
database server is configured to use SQL Server authentication.

The name of the database server to connect to. If -s is not specified,
-s <serverName>
the value at HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node
or
\ManageSoft Corp\ManageSoft \Reporter\CurrentVersion
-s
<serverName>\<instanceName> \DatabaseConnectionString is used. The registry key is present on
the compliance and inventory servers. (If you have chosen to run this script
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on the database server itself, the registry entry is not available, and you must
therefore specify the server name, or use the dot notation [.] to refer to the
current server.)
If the database is in a named instance (and not in the default database on the
server), the instance name must be specified as well.
-u <userName>

The username with which to connect to the database. This is only required
if the database server is configured to use SQL Server authentication. If not
specified, Windows Integrated Authentication is used to connect to the database
server using the current user’s credentials.

Tip • It is normal for the migration to appear to "paus"e at about the 80% mark. At this point the database is busy
restructuring for local evidence for applications, and it requires time.
Example: The following command performs the migration using the standard configuration file. Instead of recording the
log in the default log file, it will be written to the mig.log file specified in the command. Because the upgrade is running
on a new server, the database server name (and, if required, instance name) and database name must be specified, and
Windows Authentication is used to log in as the account name running the executable.
mgsDatabaseUpdate.exe -i ComplianceMigration.xml -nsu -l mig.log -s MyDBServer\thisInstance d FNMP

Check messages on the command line to confirm that the database migration was successful. If any error messages occur,
check the log file to troubleshoot the problem. Do not proceed to the next step until the database migration is successful.
For more information about database validation and remedies, see Database Validation on page 48.
10. If you are processing a copy of a previously-shared database that you split, open this database in Microsoft SQL Server
Management Studio, and complete the following:
a) Grant db_owner privileges to the security group (suggested: FNMSUsers).
b) Choose File > Open, navigate in the database migration folder in your downloaded archive (such as C:\Temp
\FNMSUpdate\Database Migration\FlexNet Manager Platform\Normal), and open
FNMP92SchemaCleanup.sql.
c) Execute this SQL script on the FNMP database.
This script removes tables, views, and functions that are related only to Inventory Manager, and not needed for the
upgrade of this database to FlexNet Manager Suite 2015.
d) If you previously changed the setting for the database Recovery model, restore the original value now.
11. Optionally, re-index the database. Consider the following factors:
•

Re-indexing increases data access speed and recovers wasted disk space.

•

On large databases, this process can take more than 24 hours. You can proceed with the rest of your upgrade and
perform this step at a later, convenient time if required.
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Tip • It is a good idea to re-index your database at least once a year. In SQL Server, tables that do not have clustered
indexes do not automatically reclaim space from deleted records. Re-indexing will reclaim this space.
If you decide to re-index at this time:
a) Start SQL Server Management Studio.
b) Open ReIndexAll.sql ( File > Open... and browse in the unzipped archive to your migration folder, such as C:
\temp\FNMSUpate\Database Migration\FlexNet Manager Platform\Normal, and select the
file).
c) Click the Execute Query tool, or press F5 to run the script.
12.
Note • Up until (and including) release 9.2 of FlexNet Manager Platform, it was an option to have the data warehouse
database for trend-based reporting (reports built in FlexNet Report Designer, powered by Cognos). While Cognos
remains optional, the data warehouse database is now mandatory, and is used by new reporting functionality within
FlexNet Manager Suite 2015.
Do one of the following:
•

If your prior implementation included the data warehouse database (you copied it to the planned SQL Server
in Splitting a Shared Database on page 40), migrate it now on its new SQL Server instance (running the
mgsDatabaseUpdate.exe program again with different parameters):
mgsDatabaseUpdate.exe -i DataWarehouseMigration.xml -nsu -d FNMPDataWarehouse
[-l logFile]
[-s serverName\instanceName]
[-u userName]
[-p password]

Important • In this instance, the database name (-d parameter) is mandatory. (The default value is shown, which you
should customize if your database name is different.)
Check messages on the command line to confirm that the warehouse migration was successful. If any error messages
occur, check the log file to troubleshoot the problem. Do not proceed to the next step until the migration is successful.
For more information about database validation and remedies, see Database Validation on page 48.
•

If your prior implementation did not include the data warehouse database, it is now mandatory, whether or not you are
using Cognos at this time. In the same archive folder, execute:
mgsDatabaseCreate -a WindowsNT -s DBserver-name\instanceName -d FNMPDataWarehouse -i
DataWarehouseCreation.xml

13. Open the data warehouse database in Microsoft SQL Server Management Studio, and grant db_owner privileges to the
security group (suggested: FNMSUsers).
14. Create a snapshot database (used for performance optimization):
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a) In the same archive folder, execute:
mgsDatabaseCreate -a WindowsNT -s DBserver-name\instance name -d FNMPSnapshot -i
SnapshotDatabaseCreation.xml

b) Open this database in Microsoft SQL Server Management Studio, and grant db_owner privileges to the security
group (suggested: FNMSUsers).
15. Create the database for FlexNet native inventory collection.

Remember • If you plan to collect both inventory data and compliance data in a single database, use the same -d FNMP
parameter as described earlier; or for a separate inventory database (recommended), use a different name as shown
below)
a) Still in the Command Prompt window on the database server, using the administrative account (FNMS-Admin), and
in the same folder of the unzipped archive, execute:
mgsDatabaseCreate -a WindowsNT -s DBserver-name\instance name -d IM -i
InventoryManagerDatabaseCreation.xml

b) Open this database in Microsoft SQL Server Management Studio, and grant db_owner privileges to the security
group (suggested: FNMSUsers).
16. Are you collecting inventory from Citrix XenApp, and are you locating the staging database on this SQL Server? If so:
a) Locate your downloaded archive Tier 1 Adapter Tools.zip, and in your unzipped archive, navigate into the
\Citrix XenApp Server Agent subdirectory.
b) Further navigate into the appropriate sub-folder for your version of XenApp:
•

XenAppAgent6

•

XenAppAgent65

•

XenAppAgent75.

c) From your chosen folder, collect a copy of the database creation/update script
SetupXenAppAgentStagingDatabase.sql.
d) Drop this SQL script on your central database server, and execute it in SQL Server Administration Studio against your
chosen database instance.
For more information about database validation and remedies, see Database Validation on page 48.

Database Validation
Database migration includes a number of checks on the quality of the resulting database.
The first of these is a check of database constraints that may have been either enabled or disabled without data checks. if
constraint errors are detected, the migration process corrects them. Where a constraint is enabled, the process also attempts to
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ensure that the data it covers is appropriate for the constraint. Generally, this succeeds without issue, and the change is simply
noted in the migration log. However, if it fails, the migration process also fails with an error similar to:
ERROR: One or more constraints cannot be enabled (step number 99).

If this occurs, the names of the constraints that cannot be enabled are listed in the migration log. Restarting the migration at
this time does not help this issue, and the database is unusable for production work. First, a database administrator or a Flexera
Software support engineer must manually correct the issue with the underlying data. Once the data has been corrected, the
migration process will be able to be restarted safely.
At the end of the migration process, there is a final schema check of the upgraded database to ensure that the upgrade has been
successful. Messages from this database check may appear in your console towards the end of the process, after the migration
itself is completed.
This check is included for the three main system databases: the compliance database, the inventory database, and the data
warehouse database.
When these checks are run, the upgrade has already been completed without errors, and the database is likely to be usable.
These are additional checks to look for irregularities in the database that may cause future operation problems. These kinds of
irregularities may occur because:
•

The earlier database had previously been changed (either by database administrators or by a Flexera Software consultant)
in ways that are not supported by the product

•

A previous migration updated the database in ways that were not entirely correct, but not previously detected

•

Something has occurred in the present migration that did not raise an error in the migration, but leaves the database in a
less than perfect condition.

Such causes can produce a range of possible issues, including:
•

Missing tables, indexes, columns, or foreign keys

•

Extra indexes, columns or foreign keys

•

Incorrectly configured columns (the size differs, or their nullability)

•

An index configured in unexpected ways, either in its uniqueness, its clustering status, or in the columns it covers.

For the above cases, assistance from a database administrator or Flexera Software support engineer is also required to correct
the schema. In many cases, the issues described in the log can be remedied in place, without requiring that the database
migration process is restarted.

Authorize the Service Account
The account used to run processing services requires permission to run as a service. Prior to installing anything, perform this
process on:
•

Your batch scheduling server/reconciliation server (in a large-scale implementation with three or more servers)

•

Your processing server (in a two server application implementation)

•

Your application server (in a single server implementation)
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•

Any independent batch servers.

Tip • You should use a singe account (that is, the same Active Directory user) for communications between the batch
scheduling server and any child batch servers. If you do not do this, you instead need to modify permissions on the
Microsoft Message Queuing configuration on the batch scheduling server (which modifications are beyond the scope of
this document). Assuming use of a single account, it is most convenient if this is the same service account used on all your
central server(s).
1. On the appropriate server, log in as an administrator (suggested: FNMS-Admin).
2. Go to:
•

On Windows Server 2012, Start > Administrative Tools > Local Security Policy

•

On earlier releases of Windows Server, Start > All Programs > Administrative Tools > Local Security Policy.

3. Select the Local Policies node, and choose User Rights Assignment.
4. Open the policy Log on as a service, and add the service account (example: SVC-fnmsservice).
5. Open the policy Log on as a batch job, and add the service account (example: SVC-fnmsservice).
6. Click OK.

Tip • A Microsoft error dialog Security Templates - An extended error has occurred. Failed
to save Local Policy Database. may appear. This error is described at http://support.microsoft.com/
kb/2411938, and may safely be ignored.

Install the Web Interface
The web interface provides the user interface to manage your inventory and license position. Continue this process as
administrator (FNMS-Admin) on either your
•

application server (for a single server installation) or

•

web application server (in a multi-server installation).

Note • Are you installing on the same server that was previously a separate administration server for FlexNet Manager
Platform 9.2 (or an earlier compliance product), where Inventory Manager was not co-located on the same server? If so, you
should now uninstall the previous version of the product so that you remove the MMC interface, deprecated from version 2014
R2. To do so:
1. On the application server, open Program and Features (Control Panel > Uninstall a Program).
2. Uninstall FlexNet Manager Platform (or your earlier compliance product, such as Compliance Manager), and then close
Program and Features.
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3. Open Windows Task Scheduler and remove the scheduled task called Execute business importer
connections.

To install the web interface for FlexNet Manager Suite 2015:
1. On the (web) application server, open Windows Explorer.
2. Copy the downloaded archive FlexNet Manager Suite 2015 Installer.zip from your staging location to a
convenient location on this server (such as C:\temp), and unzip it.

Tip • Unzipping the archive locally on each of your servers simplifies running the configuration scripts later in the
process. Notice that the entire archive must be present, as scripts reference other elements from the archive.
3. Navigate in the unzipped archive to the FlexNet Manager Suite\Installers\FlexNet Manager Suite
folder.
4. Start (double-click) setup.exe.
5. Step through the installer until asked for the Setup Type, and do one of the following:
•

For a small, single server installation combining the web application, the inventory collection, and the batch
processing functionality in one server, select the Complete option, and follow the instructions in the installation
wizard to complete the standard installation.

•

For a multi-server installation, select the Custom installation path, and select the Web Application Server for
this installation. (If this is the only functionality on this server, also ensure that Inventory Server, Reconciliation
Server, and Batch Processor are all deselected; but in fact you can combine the servers in the way that best suits your
enterprise, so make the selection that matches your server plan.)

Take note of the installation location for future reference.
6. If this server includes the batch scheduling server (or reconciliation server) functionality, you are prompted for the
credentials used for batch processes. Be sure that the account you enter already has Logon as a service permission
(see Authorize the Service Account on page 49).
7. When successful, close the installation wizard.

Install the Inventory Server
The inventory server processes all inventory collected (or augmented) by the FlexNet inventory agent.
In a single server implementation, this step is already completed and you should skip ahead to Configure the System.
For a multi-server implementation, continue this process as administrator (FNMS-Admin) on either your
•

processing server (in a two server application installation)

•

inventory server (in a three or more server application installation).

1. On the inventory (or processing) server, open Windows Explorer.
2. Copy the downloaded archive FlexNet Manager Suite 2015 Installer.zip from your staging location to a
convenient location on this server (such as C:\temp), and unzip it.

Flexera Software "Company Confidential"

Migrating to FlexNet Manager Suite 2015 On Premises

51

Upgrading FlexNet Manager Suite

3. Navigate in the unzipped archive to the FlexNet Manager Suite\Installers\FlexNet Manager Suite
folder.
4. Start (double-click) setup.exe.
5. Select the Custom installation path, and do one of the following:
•

For a two server installation, now installing your processing server, select all of the Inventory Server, the
Reconciliation Server, and the Batch Processor for this installation, and ensure that the Web Application Server is
deselected (displaying a cross).

•

For an installation using three or more servers, now separately installing your inventory server, select only the
Inventory Server for this installation, ensuring that the other options are deselected.

Take note of the installation location for future reference.
6. If this server includes the batch scheduling server (or reconciliation server) functionality, you are prompted for the
credentials used for batch processes. Be sure that the account you enter already has Logon as a service permission
(see Authorize the Service Account on page 49).
7. When successful, close the installation wizard.

Install the Batch Processors
Tip • Massive implementations may spread the batch processing load across multiple batch servers, whose processing
is controlled by the batch scheduling server (which itself also contributes to the batch processing effort). Installation of
any batch server is identical; and for the batch scheduling server, the only difference is the choice selected in the custom
installation as described below. You may follow this process for either the batch scheduling server or for any batch server.
The batch scheduling server is the integration point that correlates all your entitlement records and your consumption revealed
in inventory to work out your reconciled license position. Particularly when there is no further subdivision of this functionality
across multiple servers, this server is also known as the reconciliation server.
You do not need this process if you have either of:
•

A single-server implementation combining the web application server, the batch scheduling server, and the inventory
server in one; or

•

A two-server application implementation where you have combined the batch server and inventory server functionality on
one computer and kept the web application server as a second server.

In these two cases, this step is already completed and you should skip ahead to Configure the System.
For a three server implementation (or larger), continue this process as administrator (FNMS-Admin) on your batch scheduling
server/reconciliation server.
1. On the rbatch scheduling server (or, where applicable, a separate child batch server), open Windows Explorer.
2. Copy the downloaded archive FlexNet Manager Suite 2015 Installer.zip from your staging location to a
convenient location on this server (such as C:\temp), and unzip it.
3. Navigate in the unzipped archive to the FlexNet Manager Suite\Installers\FlexNet Manager Suite
folder.
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4. Start (double-click) setup.exe.
5. Select the Custom installation path, and make one of the following choices:
For a combined reconciliation server that performs all your batch
calculations and does not manage any further 'child' batch servers

Select only the Reconciliation Server for this
installation (ensuring that the other options are
deselected).

For a batch scheduling server that performs some batch calculations,
and also manages further batch processing on 'child' batch servers

As above, select only the Reconciliation
Server for this installation (ensuring that the
other options are deselected).

For a child batch server

Select only the Batch Processor (ensuring that
the other options are deselected).

Take note of the installation location for future reference.
6. When asked to enter the credentials to be used for running batch processes, be sure that the account you enter already has
Logon as a service permission (see Authorize the Service Account on page 49).
7. When successful, close the installation wizard.

Configure the System
PowerShell scripts are provided to complete configuration of the central application server(s), including the connections to the
databases, and then store appropriate values in the database.

Important • For a single server implementation, run the PowerShell scripts on the application server (if you have a separate
database server, you do not run the PowerShell scripts on that.) If the logical application server has been separated into
multiple servers, the PowerShell scripts must be run on each of these servers, and MUST be run in the following order:
1. web application server
2. batch scheduling server (or processing server, for a two-server application implementation)
3. Any separate batch servers
4. inventory server(s).

On each applicable server in turn, as administrator (FNMS-Admin), complete all the following steps (noticing that on
different servers, different dialogs may be presented). You should first ensure that these scripts have sufficient authorization to
execute, as described in this process.
Also notice that, to complete this configuration process, you restore IIS, the scheduled tasks, and the batch processing service
to prepare your system for operations.
1. Ensure that the SQL Server Agent service is installed and can be run on your database server(s).
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Note • By default, SQL Server Agent service is disabled on SQL Server. For on-going operation of FlexNet Manager
Suite, please ask your database administrator to ensure that SQL Server Agent is up and running. During creation of the
database, a script creates SQL jobs that require SQL Server Agent running in production.
2. On your web application server, batch server, or inventory server, ensure that Microsoft IIS is running again:
a) Ensure that your Server Manager dialog is still open.
b) In the left-hand navigation bar, expand Roles > Web Servers (IIS), and select Internet Information Services.
The IIS page is displayed.
c) In the Actions panel on the right, select Start.
A message like Attempting to start... appears. Note that it can take some time before the service is started.
When the service is running, the PowerShell scripts can update the IIS configuration as required.
3. Run PowerShell as administrator (use the 64-bit version where available):
a) Locate PowerShell. For example:
•

On Windows Server 2012, Start > Windows PowerShell

•

On earlier releases, in the Windows Start menu, find All Programs > Accessories > Windows PowerShell >
Windows PowerShell (this is the 64-bit version; the 32-bit version is Windows PowerShell (x86). ).

b) Right-click, and choose Run as Administrator.
4. In the PowerShell command window, execute:
set-executionpolicy AllSigned

Respond to the warning text with the default Y.
5. In the PowerShell command window, navigate through the unzipped downloaded archive to the Support folder.
6. On each server, execute:
.\Config.ps1 "Config\FNMS Windows Authentication Config.xml" updateconfig

(This script determines the type of server installation, and applies appropriate configuration. See also server-specific
comments below.)
On each server, on first run PowerShell asks whether to trust the publisher of this script. You may allow Run always for a
certificate signed by Flexera Software LLC.
7. In each case, allow the script to run once, completing the requested details.

Tip • Helpful notes:
•

Use the service account details you created earlier (example: SVC-fnmsservice).

•

Separately on each dialog, the check box Use the same credentials for all identities copies the account details from
the upper section to the lower section of the dialog.

•

For externally visible URLs, you can specify either HTTP or HTTPS protocol, and either the flat server name or the
fully qualified domain name is supported. Any port number is optional. Valid examples:
http://servername
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https://www.servername.mydomain:8080

•

The PowerShell script asks for appropriate database connection details, depending on the configuration of the current
server (for example, if the current server includes inventory server functionality, the script asks for the Inventory
Management database). In each case, supply the host server name (and, if the database instance is not the default
instance, the instance name, separated by a backslash character); and the database name for each kind of database.
In a small-to-medium implementation, all the databases may be on the same host and instance combination; but in
larger implementations may be separated onto distinct servers. In either case, each database has a distinct database
name, for which the defaults are:
•

The main compliance database: FNMP

•

The database for inventory collected by the FlexNet inventory agent: IM

•

The data warehouse for trend reporting: FNMPDataWarehouse

•

The snapshot database for performance improvement: FNMPSnapshot.

8. Close the PowerShell command window.
9. If this is your batch scheduling server (or the server hosting that functionality), ensure that the services for FlexNet
Manager Suite Batch Process Scheduler are running:
a) Navigate to Start > Control Panel > Administrative Tools > View local services.
The Services dialog opens.
b) In the list of services, ensure that both FlexNet Manager Suite Batch Process Scheduler and
FlexNet Manager Suite Batch Processor are both running. If not, right-click each stopped service in
turn, and from the context menu, select Start.

Note • These services are critical to the operation of FlexNet Manager Suite. It is best practice to set up your service
monitoring to alert you any time either of these services is stopped.
10. On your batch server or inventory server, enable all Windows scheduled tasks related to FlexNet Manager Suite.
The scheduled tasks are different on the two different types of servers. On your batch scheduling server (also known as
reconciliation server), change all tasks in the FlexNet Manager Platform folder:
•

Data warehouse export

•

Export to ServiceNow

•

FlexNet inventory data maintenance

•

Import SAP inventories

•

Import SAP package license

•

Inventory import and license reconcile

•

Recognition data import

•

Regenerate Business Import config
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•

Send contract notifications.

On your inventory server, change all tasks in the FlexNet Manager Platform folder:
•

Import Active Directory

•

Import application usage logs

•

Import discovery information

•

Import installation logs

•

Import inventories

•

Import Inventory Beacon activity status

•

Import Inventory Beacon status

•

Import remote task status information

•

Import security event information

•

Import system status information

•

Import VDI access data.

An example process to change these tasks on Windows Server 2008:
a) Open your Computer Management dialog (for example, clickStart, right-click on Computer, and select Manage
from the context menu).
a) In the left-hand navigation bar, expand Configuration > Task Scheduler > Task Manager Platform, and select the
FlexNet Manager Platform folder.
b) Select all of the relevant tasks in the list (click the first, shift+click the last), and in the Actions pane, in the Select
Item section, click Enable (or right-click the selection, and click Enable).
c) Close the dialog.

(Re-)Activate the Product
You need to reimport your license for FlexNet Manager Suite.
The migration process requires that the license is reimported on the batch scheduling server, or, in smaller implementations,
the server hosting that functionality:
•

The application server (in a single server implementation)

•

The processing server (in a two server application implementation)

•

The batch server (in a three server application implementation).

1. On the appropriate server, save a copy of your license in a convenient folder (such as your installation folder), where it is
accessible for this activation process.
2. In Windows Explorer, navigate to the Installation-Dir\Dotnet\bin folder.
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3. Execute (double-click) ManageSoft.Activation.Wizard.exe.
4. Import your license to use FlexNet Manager Suite.

Populate the Downloadable Libraries
FlexNet Manager Suite comes with an Application Recognition Library, a SKU (stock keeping unit) Library, and several
Product Use Rights Libraries (the latter depending on which options you have purchased for the product). These are updated
regularly by Flexera Software and normally downloaded automatically. At installation time, however, you need to download
the libraries to create a baseline ready for product use.

Tip • New functionality in this release, including the recognition of Microsoft Server applications, relies on the latest updates
of the downloadable libraries.
Complete this procedure as administrator (FNMS-Admin), having database rights as described in earlier sections.
1. On the processing server (or application server for a single-server implementation), open a Command Window and
navigate to installation-folder\DotNet\bin\.
2. Execute MgsImportRecognition.exe.
The utility downloads all libraries according to the terms of your license, and imports them into FlexNet Manager Suite.
On this server, the Windows scheduled task Recognition data import updates these libraries, by default at 1am daily.

Import the Sample Reporting Package
This section is only for those using FlexNet Report Designer (powered by Cognos). Even if the installation of FlexNet Report
Designer (and Cognos) is shared with (say) FlexNet Manager for Engineering Applications, you must still complete this
process.
First, be aware that much of what used to be published in the Report Designer environment in the 9.2 product is now moved
into the web interface for FlexNet Manager Suite itself. Compare the functionality of the two releases:
Release 9.2

Release 2015

A product dashboard was available within the Reports
Designer.

The product dashboard is now one of the main management
tools in the web interface.

A number of business reports were available in Report
Designer.

Business reports are now centered in the reports area of
the web interface (switch to reporting mode using the large
button in the header bar).

Trend analysis reporting was provided only through Report
Designer.

Trend analysis reporting is available directly through the web
interface.

Reports provided through Report Designer were available
through a web portal, providing click-through access.

There is no longer any direct link from the web interface
of FlexNet Manager Suite to reports prepared in Report
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Release 9.2

Release 2015
Designer. Users must be given a direct link to those reports,
external to the product.

Tip • Custom reports in Report Designer can still retrieve
data from the FlexNet Manager Suite database.
Reports in Report Designer were central to the operation of
the system.

Many reports are still provided in Report Designer, but these
are intended as examples to help you build your own reports.

If you wish to proceed with custom reporting through FlexNet Report Designer, use this process to update your reports
package for the new release.
1. Locate the registry key value for the Dispatch URL for FlexNet Report Designer that you noted in Identify and Update
Inventory Manager Server on page 28.
2. Log in to your Report Designer (Cognos) server, and navigate to
reportDesignerInstallationDirectory\c10\deployment.

Tip • If this folder does not already exist, create it.
3. Copy your Report Designer Package - Single Tenant (FlexNetManagerPlatformReportsAndDashboard.zip)
to this folder.
You downloaded this package as you worked through Download the Materials on page 25.

Important • Do not change the file name. This file name and location are both requirements.
4. You may log out of the Report Designer (Cognos) server now.
Shortly you will log into your batch scheduling server, but first there are permissions to set.
5. In the web interface for FlexNet Manager Suite 2015, add your current account (suggested: FNMS-Admin) as a Web
Administrator for the business reporting portal as follows:
a)

Navigate through the system menu (
The Accounts page opens.

in the top right corner) > Accounts.

b) Select the Roles tab, and check for the existence of the Business Reporting Portal Admin role.
If the role does not already exist, you can create it.
c) Click the edit (pencil) icon at the right-hand end of the card for this role.
The properties page for this role appears.
d) Expand the Business reporting portal tab of the accordion, and from the Privileges option list, ensure the Web
Administrator role has Allow permissions.

Flexera Software "Company Confidential"

Migrating to FlexNet Manager Suite 2015 On Premises

58

Upgrading FlexNet Manager Suite

e) Switch to the All Accounts tab, locate your current account (suggested: FNMS-Admin) in the list, and click the
account name hyperlink.
The page switches to show Account Properties for your account.
f) Under the Permissions section, check whether your Business Reporting Portal Admin role is already
listed against the Role. If so, you are set for permissions, and should continue with step 6 on page 59.
g) Click the + button to the right of your current Role (typically, Administrator) to add your account to another role.
A duplicate line appears with another option list of all the roles defines so far.

Tip • Each enterprise is licensed for only a single operator in the web administrator role. If one has already been
defined, you need to move that account out before you can add yourself.
h) From the duplicate option list, select your Business Reporting Portal Admin role.
The Business reporting portal tab of your resulting list of privileges is updated. If you expand this tab of the
accordion, you see that Web Administrator now displays Allowed access.
i) Scroll to the bottom of this page, and click Save.
Your account is now the (only) web administrator for use of the Report Designer.

Tip • Report Designer also requires that this account is valid in Active Directory.
6. Using the same account, log into your batch scheduling server directly.
Refer to your block diagram of servers to identify this machine. If you have combined servers, this may be your
processing server, or your application server.
7. Navigate in Windows Explorer to installation-folder\Cognos
\BusinessReportingAuthenticationService\bin.
Example:
C:\Program Files (x86)\Flexera Software\FlexNet Manager Platform\Cognos
\BusinessReportingAuthenticationService\bin

8. Right-click CognosPackageImport.exe and Run as Administrator.
A window appears for the Flexera Report Designer Package Import Utility.
9. Click Update....
An Update Value dialog appears.
10. Copy the Dispatch URL from your earlier note (see step 1 on page 58) into the Value field, and click Update.
The value entered is written into the registry on this server, and the additional dialog disappears.

Tip • If you run this import utility on the same machine in future, it displays the value stored in the registry in its readonly Dispatch URL field.
11. Click Install Reports Package.
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Progress is logged in the text window of this dialog as the package is imported into the Cognos database. When
successfully completed, the last line displays Finished publishing the Report Designer package.

Important • Do not close the utility until it has finished the import! This process may take several minutes.
The Reports Designer reports are now available as baselines for your own customization and extension as required.
The reports can be accessed in a web browser at http://Cognos-webserver:port/cognos10/cgi-bin/
cognos.cgi? (A typical port number is 8889, but check the value in your implementation.)

Configure Web Browsers
Efficient use of FlexNet Manager Suite may required adjusting your web browser settings (especially for Microsoft Internet
Explorer).
Assumption: Microsoft IIS is running on your central web application server.
1. In your preferred web browser, navigate to the URL server-name-or-IP-address/Suite/Help/webhelp/index.html.
2. Expand the table of contents on the left by clicking the book icon to the left of the title.
3. Click Configuring Your Web Browser, and follow the guidelines in the column for your preferred web browser.

Link to Flexera Service Gateway
Flexera Service Gateway allows interaction between separate products from Flexera Software.
The ability to link FlexNet Manager Suite to the Flexera Service Gateway is subject to a separate license option. If you
have licensed this option (you can check using the process below), you need to configure the connection as part of your
configuration process.
To complete this process, you must know credentials that can log into your Flexera Service Gateway server with administrator
privileges.
1. Log into the web interface for FlexNet Manager Suite.
2. Optionally, check that you have licensed the option to link to Flexera Service Gateway:
a)

Navigate to the system menu (
in the top right corner) > FlexNet Manager Suite License.
The Your FlexNet Manager Suite License page appears.

b) Check the Subscription details on the left-hand side.
If you have licensed this option, FNMP API integration enabled: Yes appears in the list. If it is not
visible, you cannot continue with this procedure.
3.

Navigate to the system menu

> System Settings, and select the Web API tab.

Note • This tab is available only if your enterprise has licensed the FNMP API integration option.
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4. Click each of the links in turn to download the two files, and save them to a convenient location (such as C:\temp).
There must be network access to your Gateway server from the location where you save the files.
5. Either, in your web browser's list of recent downloads, click the registration tool to open it; or
a) Open a Command Window, and navigate to the location where you downloaded the files.
b) Run RegisterFlexeraServiceGateway.exe.
The Flexera Service Gateway Registration dialog appears.
6. Identify the Flexera Service Gateway host, the server in your enterprise where the Gateway is installed, and the Port
number.
You may use an IP address, a fully qualified domain name, or (if your DNS is correctly configured and accessible) the
server's host name. The default port number is 9443.
7. Provide the credentials for administrator access to the Gateway account.
8. Us the Import button to browse to the other downloaded file, FlexNet Manager Suite Web API
configuration, and import it into the registration tool.
9. Click OK.
Registration is complete. (You do not need to repeat this registration on others of your central servers.)

Update Access Rights
Through your processes of database migration, all the access rights that applied in your earlier compliance product are carried
forward into FlexNet Manager Suite 2015.
In addition, if you created a new account for installation (suggested: FNMS-Admin), this account defaults to having
administrator privileges in your new implementation, in addition to the migrated access rights. This account has adequate
rights to modify access rights for other operators.
If you wish to modify access rights:
1. Open the web interface to FlexNet Manager Suite 2015.
2.

Navigate through the system menu (

in the top right corner) > Accounts, and ensure that the Roles tab is selected.

3. For each unique set of access rights, ensure that there is (or create) a distinct role, and set its rights by expanding the
various headings in the accordion and using the controls inside. (For unusual combinations, start by selecting Custom
from the option list in each section.) Remember to scroll down and click Save (or Create) when you make any changes.
4. When appropriate roles are defined, switch to the All Accounts tab.
5. Find each account in the list in turn, and click the hyperlinked account name to open its properties.
6. Change the roles assigned, or add additional roles, to each account as required.
The net effect of all roles on permissions for this account is displayed in read-only mode in the accordion below as you
make changes. (Remember that a 'deny' in one role over-rides an 'allow' in another role when the same account is assigned
to both roles.)
7. Remember to Save each changed account.
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Deploying Inventory Beacons in Migration Mode
Before deploying inventory beacons, choose whether to use additional targeting of inventory devices as part of your migration
strategy.

Production mode adopts all who ask
When FlexNet Manager Suite 2015 is in production, any inventory agent (installed on a device) that contacts an inventory
beacon receives a response:
•

If the device fits within any target specified in the web interface on the application server, it receives the options defined
for that target group (specifically, whether devices within the target group should be 'adopted' by having an inventory
agent installed, and whether application usage should be tracked on devices in the group).

•

If the device is not covered by any target, it receives (in production mode) default options (those options are not to install
the agent, and not to track application usage). However, in receiving these default options, the device also is notified of all
known inventory beacons, and the common schedule for any future actions that may be applied to it in future. From that
time on, the inventory agent on these devices reports through the inventory beacons to FlexNet Manager Suite 2015, and
has been migrated.

This last fact is critical for migration. Your existing estate includes many inventory agents that you have updated and are now
looking for a response from an inventory beacon (and, until they receive one, failing over to the old hierarchy of distribution
servers). In production mode, every one of those managed devices would switch over to the inventory beacon hierarchy in
2015 as soon as it contacted its first inventory beacon. In a simple migration, this may be the desired behavior; but in a large
estate, you may wish to target a pilot group, which requires that we prevent the sociable behavior of giving every managed
device the default response.

Tip • Don't forget that, to contact either a distribution server (in 9.2) or an inventory beacon (in FlexNet Manager Suite
2015), each inventory agent (on a managed device) must be able to log in to that server. Within 9.2 systems this is not a
problem, since those managed devices have long ago received the account name and password for any distribution servers set
up to require Basic Authentication. However, when those same managed devices attempt to switch over to 2015, they have not
been supplied with any credentials for new inventory beacons. Therefore, any inventory beacons used to 'bootstrap' inventory
agents into the new system must use anonymous authentication, so that managed devices can access them (without requiring
any password). In most cases, this is not an issue: anonymous authentication is the default for newly-installed inventory
beacons. There may be two or three special cases where this becomes important:
•

If you have an inventory beacon in (say) a demilitarized zone, facing the Internet, where you require Basic Authentication.

•

If the inventory beacon is installed on the batch scheduling server (or, in smaller implementations, the server including
that functionality). In this case, alone of all inventory beacons, the default is Basic Authentication to improve security
of your central server. (You may prefer to turn off Basic Authentication for this beacon, at least during the migration
project.)

•

If the person installing the inventory beacons has changed them to require Basic Authentication more broadly than either
of the above.

When Basic Authentication is unavoidable, ensure that you also have other inventory beacons with anonymous authentication
(at least during the migration period). Otherwise, you may need to visit managed devices to record the authentication details
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for beacons they need to contact. Of course, these authentication details are not supplied automatically by download through
the system.

Migration mode rejects outsiders
To allow for controlled migration of inventory agents, there is a control in the beacon settings page of the web interfacethat
switches FlexNet Manager Suite from production mode to migration mode. In migration mode, devices already identified in
target groups within FlexNet Manager Suite still receive their options as always; but the difference is that those devices not
included in any target group receive a "not found" 404 response to their request, and therefore continue to fail over to their old
hierarchy of distribution servers, staying within the 9.2 system.

Choose your strategy
Therefore, your strategic decision about switching over your managed devices is this:
•

Do we want every managed device on day one to switch over to the new system? If so, clear the Migration mode:
Restrict inventory settings to targeted devices check box (Discovery & Inventory > Settings, in the Beacon settings
group). While this setting was automatically turned on during database migration (ready for a more conservative roll-out),
clearing the check box leaves you in production mode, and every managed device switches to the new inventory beacons
as soon as it requests a policy update.

•

Or do we want a staged migration using test machines and pilot groups? If so, ensure that the Migration mode: Restrict
inventory settings to targeted devices check box remains set.

Accepting the latter (default) option gives you another safety net of staging or targeting your switch over of managed devices
from 9.2 to FlexNet Manager Suite 2015:
1. You may, in Inventory Manager 9.2, have used selection of your old distribution servers to control which managed devices
received the update package that allowed migration (see Distribute Self-Upgrade and Settings Packages on page 36).
2. Still in Inventory Manager, you may have used security policy targeting of the managed devices that were to receive the
same update package.
3. Now, even though large numbers of your managed devices stand ready to make the switch, only those you specifically
target in FlexNet Manager Suite 2015 can do so.
Once you get past the pilot stage and are confident that migrated managed devices are functioning well in the new system,
you simply clear the Migration mode: Restrict inventory settings to targeted devices check box. This switches your entire
system (and all its inventory beacons) into production mode. At that point, any managed devices that were prepared with the
upgrade package but have not yet been targeted can freely and automatically switch over to the new system.

More about targets
Notice that simply defining targets in FlexNet Manager Suite is the enabling step for the switch-over. If an upgraded managed
device is identified in a target, it can switch. It does not require a specific rule (actions plus targets plus schedule) to be
defined.
The definitions of targets are cumulative: that is, a device identified in any target group is able to make the switch. For this
reason, these upgrade notes suggest starting with a single target in the new system so that it is simple to maintain control.
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The use of targets is also independent of the roll-out of inventory beacons. That is, if you have no targets to begin with,
you may roll out as many inventory beacons as you like, and they will continue to reject managed devices as long as the
Migration mode: Restrict inventory settings to targeted devices check box remains set.

Set Defaults and Migration Mode
Prepare your inventory settings for deployment of inventory beacons.
These settings are applied to all FlexNet inventory agents reporting to FlexNet Manager Suite through the hierarchy of
inventory beacons. You can fine tune your settings at any time; but right now, you can configure some settings useful for your
migration process.
1. On a convenient computer, start a web browser and access the URL server-name-or-IP-address/Suite/.

Tip • Consider doing this from your central batch scheduling server, and once you have completed these settings, you can
continue there to install the local inventory beacon on the same server.
2. Navigate to Discovery & Inventory > Settings.
The Inventory Settings page is displayed.
3. In the File inventory section, select Do not collect file inventory.
During migration, you do not want your inventory agents undertaking time-consuming work before reporting to their new
inventory beacons. You may change this setting later for operational purposes as required.
4. In the Agent inventory schedule section, use the controls available to set the schedule for all installed inventory agents to
collect inventory from their managed devices.
You can mimic the same schedule that applied to the majority of your devices under the 9.2 system. Remember that this
same schedule applies to all inventory agents reporting to FlexNet Manager Suite through inventory beacons.
5. In the Beacon settings group, keep the default values for Interval for beacon updates and Beacon version approved for
use. These control the self-updating behavior of the inventory beacons (not the inventory agents that report to them), and
you can adjust these later as required.
6. Still in the Beacon settings group, do one of the following based on your strategy for migrating managed devices:
•

(Recommended) To require specific targeting of managed devices within FlexNet Manager Suite 2015 before those
devices can automatically migrate, ensure that the Migration mode: Restrict inventory settings to targeted devices
check box remains set (checked, or ticked).

•

To allow any managed device that contacts an inventory beacon to immediately switch over to FlexNet Manager Suite
2015, clear the Migration mode: Restrict inventory settings to targeted devices check box.

7. In the bottom right of the page, click Save.
Your inventory settings are ready for delivery to any managed device that is accepted by an inventory beacon.

Deploy Inventory Beacons
Inventory beacons are the data-gathering arms of your compliance system.
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Ensure that you have reviewed your policy for migrating inventory agents before deploying any inventory beacons (see
Deploying Inventory Beacons in Migration Mode on page 62), and set migration mode accordingly (see Set Defaults and
Migration Mode on page 64).
The process for installing and configuring inventory beacons starts from the web UI for FlexNet Manager Suite.

Note • Any computer on which you will install an inventory beacon must have at least version 3.0 of PowerShell installed.
For more information, see Upgrade PowerShell on Inventory Beacons on page 23.

Important • When you are migrating from 9.2 or earlier, it is mandatory to install an inventory beacon on your central
batch server (or, for combined servers in smaller implementations, your processing server, or your application server).
This inventory beacon allows you control of content migrated forward from 9.2, where inventory beacons installed on
separate servers cannot have similar privileges. This inventory beacon must be a top-level beacon reporting directly to
the neighbouring inventory server, and optionally it may also be the root of your inventory beacon hierarchy (or you may
have many peer top-level beacons). Notice further that the user account that will access this inventory beacon, because it is
directly accessing the batch server that had the central beacon installed, must be a member of the security group (suggested
as FNMSUsers) that has database owner privileges (see Upgrade/Create Databases on page 43). Finally, notice that
its default settings, requiring Basic Authentication for devices to access it, mean that it cannot be used for bootstrapping
inventory agents on managed devices from the 9.2 system to the 2015 system (as discussed in Deploying Inventory Beacons in
Migration Mode on page 62). You may either:
•

Switch this inventory beacon on the batch server to accept anonymous authentication

•

Use other inventory beacons for bootstrapping managed devices.

1. Log in on the computer where the inventory beacon is to be installed, and start a web browser there to access the URL
server-name-or-IP-address/Suite/.
2. In the Discovery & Inventory menu, under the Network group, select Beacons.
3. Click Deploy a beacon.
The Deploy a Beacon page appears. Ensure that the default Download beacon section of the accordion is open.
4. Click Download beacon.
5. Use the web browser dialog to save the installer to a convenient directory on the inventory beacon computer (such as C:
\temp).
6. In Windows Explorer, navigate to the saved file, and double-click it to run the installer.
7. Step through the installation wizard, using the summaries in the accordion section Beacon setup or the more detailed
online help available through the web interface to assist as necessary.
8. When the configuration of this inventory beacon is complete, log in to the next server where you would like to install the
FlexNet Beacon software, and repeat this process for each beacon.
9. If your sites and subnets are not already recorded in your database, you should either import them from Active Directory,
or enter them manually.
Subnets are visible in the web interface for FlexNet Manager Suite 2015 at Discovery & Inventory > Subnets (in the
Network group). Subnets must be recorded, and assigned to inventory beacons, before beacons can target any devices
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for migration. For guidance about importing or entering sites and subnets, open the online help in the web interface and
navigate to FlexNet Manager Suite Help > What Is an Inventory Beacon? > Importing from Active Directory.
10. In FlexNet Manager Suite, navigate to Inventory > Unassigned Subnets.
11. Select one or more of the subnets in the list.
You may select subnets for either of two reasons:
•

To disable them so that no managed devices in those subnets can be targeted. To do this, click Ignore, and they
disappear from the list. (Find them again later in the All Sites list.)

•

To assign them to beacons so that managed devices in those subnets can be targeted for switching to the new system,
and they can collect inventory directly into FlexNet Manager Suite. In this case, continue.

Tip • Be sure that both the subnet and any beacon you want to assign to it have a status of Enabled.
12. Click Assign to a beacon.
A new list opens above that button, showing available beacons for your selection. To help with logical groupings of
subnets, each beacon also displays subnets already assigned to it. The status of each beacon is also displayed on the right
of the list, so that you do not accidentally assign any subnets to a disabled beacon.
13. Select one beacon from the list, and click Save.
The list of beacons closes, and the assigned subnet is removed from the list of unassigned subnets.
You are now ready to target managed devices to switch over to the new system.

Create a Roll-out Target
Create a target group for piloting the switch-over of managed devices to the new system.
Refer back to your switch-over strategy (see Deploying Inventory Beacons in Migration Mode on page 62 and Set Defaults
and Migration Mode on page 64):
•

If you chose a blanket switch-over without further targeting (the Migration mode: Restrict inventory settings
to targeted devices check box is clear), skip down to step 8. Your managed devices are already switching over
automatically, and you can start reviewing results.

•

If you chose a pilot roll-out approach (the Migration mode: Restrict inventory settings to targeted devices check box is
set (checked, ticked), continue from step 1 of this procedure to select your initial machines to switch to the new system.

Tip • Remember that only targets (not complete rules) need to be defined in FlexNet Manager Suite at this time, and that
any device identified in any target that contacts an inventory beacon will immediately switch to operations in the new 2015
system. For a staged roll-out, then, it is convenient to define only one target at first, so that you can assess the results before
approving a wider group.
1. In the web interface, navigate to Discovery & Inventory > Discovery and Inventory Rules.
2. On the left, select the Targets tab.
3. On the right-hand side, click Create a target.
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The page is replaced by the Create an Inventory Target page.
4. Give this target group a helpful Name (suggestion: Device Migration) and in the Description field, record any notes
helpful to other operators, or to yourself after the purpose of this group is forgotten over time.
5. In Define machines to target, leave the first choice as Include, and from the Select target... option list,
choose a targeting method.
Additional controls appear allowing you to provide details appropriate to your chosen method. For example, the first time
you might choose All machines with a name like... and then identify the machine name of your first test
computer. Later, when the initial test is successful, you can change this target to define a whole subnet.

Tip • Using the + control at the end of your first definition, you can add additional lines to your definition of this target.
For example, you might have your first line target a subnet, and subsequent lines Exclude specific servers by name
within that subnet.
The other options on this page are not relevant to the purpose of switching over managed devices that are already deployed
(in this case, through Inventory Manager 9.2).
6. Click Create (in the bottom right of the page).
Your new target is updated to your inventory beacons (by default, every 15 minutes or so).
7. If you have not already targeted your update packages to managed devices through Inventory Manager 9.2 (see Targeting
the Inventory Agent Upgrades and Migration on page 37), do so now!
Three factors are now aligned:
•

Inventory beacons are in place

•

Targets in FlexNet Manager Suite identify your pilot machines for switching to the new system

•

Existing managed devices (from 9.2) are upgraded with instructions to look for inventory beacons.

Now, the upgraded managed devices attempt to connect to an inventory beacon. Until the beacon is ready, they receive a
404 not found error, and revert to using the 9.2 hierarchy of distribution servers (operating as normal in the old system).
When the beacon is ready but the individual managed device is not listed in any target, that device also receives a 404
error and fails over. Only devices matching the filters you established for this target group, contacting any inventory
beacon, collects your inventory settings (see Set Defaults and Migration Mode on page 64) and switches permanently
to reporting through inventory beacons to FlexNet Manager Suite 2015.
8. To prevent inventory imported through FlexNet Manager Suite 2015 being hidden by old inventory still being imported
from Inventory Manager 9.2, ensure that Inventory Manager is not the primary inventory source:
a) In the System menu (gear-wheel icon in the top right corner), choose Data Inputs.
b) Select the Inventory Data tab.
The list of inventory connections is displayed. Most of these are imported from your previous 9.2 implementation.
Only one of them is Primary, with all the others showing a Make primary button.
c) If the connection to Inventory Manager 9.2 (default name: ManageSoft — Flexera) is currently the primary
connection, click the Make primary button for the FlexNet Manager Suite — Flexera connection.
New inventory imported through the inventory beacons into 2015 will now be displayed in inventory results.
9. Wait.
Time passes while
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•

The inventory beacons collect your changed target specification

•

Managed devices try to access the inventory beacons, and the pilot group members are now accepted, receiving their
new inventory settings

•

On the schedule you configured, inventory agents collect inventory from their local machines, and upload the results
to an inventory beacon

•

The inventory beacon, within ten minutes, uploads the results to a web handler on your inventory server, which stores
the results into the inventory database

•

The compliance import and calculation that happens by default at 2am daily collects from the inventory database and
imports into the compliance database as required for license calculations.

Some of these processes can be manually triggered; otherwise come back tomorrow, or worst case the next day.
10. In the web interface, review the inventory results collected from your test device(s) (for example, Discovery & Inventory
> All Inventory [in the Inventory group]).
When satisfied, repeat this process to redefine the target group to include a wider range of devices, and continue until
satisfied that everything is working as expected. As machines successfully switch over to the new system, you may also
choose to move them out of the Device Migration target and into a production target.

Tip • Moving devices is preferable to simply removing them from a target, since removal means that when the managed
device next accesses the inventory beacon to check its settings, it receives a 404 not found response (it continues to report
its inventory on the previously received settings). Once a successful device is moved to a production target, you are
'finished' with the device, no longer needing to remember to come back and tidy up later.

Note • If you are not satisfied with your test cases, you may revert these devices to use the old system. In Inventory
Manager 9.2, use remote execution on those devices to do a policy 'update' back to your last applicable policy for 9.2. You
do not need to roll back the inventory agent as well, as the 2015 inventory agent is backward compatible with your 9.2
system. Switching between the old and new systems is controlled by the policy applied to the managed device.
11. When you are satisfied with test results and no longer need a pilot group, navigate to Discovery & Inventory > Settings
page, and clear the Migration mode: Restrict inventory settings to targeted devices check box.
Restricted targeting of managed devices in FlexNet Manager Suite is now turned off. All managed devices that received
the upgrade package quickly switch over to the new inventory beacon hierarchy, and receive at least a default policy.
You may remove the migration target from your list of targets. It is best practice to ensure that all devices are covered by
production target groups, so that you can control the settings they receive.

Tip • FlexNet Manager Suite 2015 records a list of inventory connections under the system menu (
in the top right
corner of the web interface), Data Inputs, on the Inventory Data tab. If you inspect this now, you see the inventory
connection to your old Inventory Manager in the list. You cannot modify the connection details within the web interface.
In the new system, connection details must be edited on the responsible inventory beacon (shown in brackets on the list).
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In the case of the 9.2 Inventory Manager connection, the responsible beacon is the one installed on your central batch
scheduling server.
12. Return to Inventory Manager 9.2, and monitor the declining traffic as managed devices switch over to the new system.
When you think a distribution server might be finished with (because all its managed devices have switched over), visit
the distribution server and disable uploads. Then in Inventory Manager, monitor the Distribution Status (click the All
link), and the count of Logs (and Delayed Logs) should remain at zero. If not, it means that managed devices are still
uploading content to this distribution server — you can inspect the log on the distribution server to identify the managed
device that has not switched over (validate against your plan whether this device is intended to migrate or to stay with
Inventory Manager 9.2). Once the count of logs stabilizes at 0, you can decommission the distribution server, potentially
re-purposing the machine as an inventory beacon somewhere in your new system.

Migrating Citrix Inventory Collection
If your previous implementation collected inventory from XenApp or XenDesktop, it's likely that rework is required.
If your previous 9.2 implementation was collecting inventory from Citrix XenApp and XenDesktop, the inventory rules are
not carried forward in your new FlexNet Manager Suite 2015 implementation. Citrix has largely reimplemented these products
from version 7, and your new implementation supports version 7.5 (along with versions 6.0 and 6.5). To extend this support, a
redesign of the adapters to import XenApp and XenDesktop inventory has been necessary.
If you are preserving Inventory Manager 9.2 as an inventory source, any existing inventory import from XenApp or
XenDesktop to that system continues to operate. If you wish, you can use your adapter connecting with Inventory Manager to
import the results of those inventory collections to FlexNet Manager Suite 2015.
However, if you wish to import inventory directly from XenApp or XenDesktop to FlexNet Manager Suite, please follow the
appropriate procedures from the following two sections.

Update the XenApp Adapter
The updated XenApp adapter requires updates to the XenApp server agent, the staging database, and the method of collecting
Active Directory data.
1. Check the inventory beacon update is complete (see Update, and Deploy Additional Inventory Beacons and sub-sections).
2. Be sure that you have completed an import from Active Directory from all relevant domains.
For set-up details refer to FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page.
3. If you did not already update your staging database for this adapter in your central database server (as described in
Upgrade/Create Databases):
a) Locate your downloaded archive Tier 1 Adapter Tools.zip, and in your unzipped archive, navigate into the
\Citrix XenApp Server Agent subdirectory.
b) Further navigate into the appropriate sub-folder for your version of XenApp:
•

XenAppAgent6

•

XenAppAgent65
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•

XenAppAgent75.

c) From your chosen folder, collect a copy of the database creation/update script
SetupXenAppAgentStagingDatabase.sql.
d) Drop this SQL script on the database server hosting your staging database, and execute it in SQL Server
Administration Studio against your chosen database instance.

Tip • If you have more than one of these staging databases, repeat this process until they are all updated.
4. Ensure that the appropriate inventory beacon(s) has/have a connection configured for the staging database(s), and that the
connection is scheduled for regular operation.
For details, check FlexNet Manager Suite Help > Adapters Supplied by Default > XenApp Server Adapter > Setting Up
the XenApp Server Adapter > Create Connections for Data Upload.
5. On each of your XenApp controlling servers where FNMPXenAppAgent.exe is installed, replace the executable with
the correct version from the unzipped archive.
For details, check FlexNet Manager Suite Help > Adapters Supplied by Default > XenApp Server Adapter > Setting Up
the XenApp Server Adapter > Installing the XenApp Server Agent.
6. As required, create or update a scheduled task to execute the upgraded XenApp server agent.
See the adjacent help topic Create a Scheduled Task.

Tip • Pay particular attention to the schedule for the agent, and the schedule of the inventory beacon import from the
staging table. These two activities must not overlap.
The XenApp adapter is now ready for operation. On schedule, the agent populates the staging database; on the later schedule,
the staged data is collected by the inventory beacon and uploaded to the central server; finally, when the next inventory
import and compliance calculation is run, the XenApp applications and the users who can access them are available, at least
as installer evidence and file evidence, within FlexNet Manager Suite. You may additionally need to link the evidence to
applications, and to ensure these applications are licensed. For more information, see the other online help topics under
FlexNet Manager Suite Help > Adapters Supplied by Default > XenApp Server Adapter.

Update the XenDesktop Adapter
The best practice configuration for the XenDesktop adapter is to allow direct network access from the appropriate inventory
beacon to the XenDesktop broker. (Where this is not permitted, you can copy the appropriate PowerShell script to the
XenDesktop broker, execute it locally, and copy the generated .vdi and .ndi files to the Incoming folder on the relevant
inventory beacon.)
As this adapter relies on PowerShell scripts run from the inventory beacon and executing on the XenDesktop broker, both
these servers must allow at least RemoteSigned execution policy for PowerShell, as described below.
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If you are upgrading from an earlier version of the XenDesktop adapter, notice that you must run the Active Directory import
separately, and prior to exercising the adapter, as listed below. Failure to do this risks the removal of previously-gathered
inventory of VDI access to applications.
1. Check the inventory beacon update is complete (see Update, and Deploy Additional Inventory Beacons and sub-sections).
2. Be sure that you have completed an import from Active Directory from all relevant domains.
For set-up details refer to FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page.
3. On each of the inventory beacon and the XenDesktop broker, check the execution policy for PowerShell scripts:
a) On each machine in turn, open a PowerShell window.
b) At the prompt, enter Get-ExecutionPolicy.
Usable settings include RemoteSigned, AllSigned, or Unrestricted (although the latter is not
recommended).
a) If the current policy setting is Restricted, run the following command to set it to RemoteSigned:
Set-ExecutionPolicy RemoteSigned

4. Create (or update) discovery and inventory gathering rules to target your XenDesktop brokers:
a) In the web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Discovery group > Discovery
and Inventory Rules.
b) Select the Targets tab, click Create a target, and complete the details to target your XenDesktop broker(s). Click
Save to add your new target to the list of available targets. (If necessary, repeat to create multiple targets.)
c) Select the Actions tab, click Create an action, and give your new action a useful name and description.
d) Expand the XenDesktop environments heading in the accordion list, and select both Discover XenDesktop
environments and Also gather XenDesktop environment inventory. Then click Create to record your new action.
a) Select the Rules tab, click Create a rule, and in the rule builder that appears, click the View Actions... hyperlink.
b) For the rule you just created, click Add to rule builder, and in the rule builder, click the View Targets...
hyperlink.
c) For the target(s) you defined, click Add to rule builder, and in the rule builder, click Schedule.
d) Complete the scheduling details, and click Save as.
e) Give your rule a meaningful name, and click Save.

Tip • After a little time (say, 30 minutes) to allow for the relevant inventory beacon to collected its updated rules, you
can inspect the rule on the applicable inventory beacon, in its Rules page. (If it hasn't updated yet, click Update now.)
5. After the XenDesktop adapter runs (according to the schedule you just created), and after the subsequent inventory import
and compliance calculation, you can inspect the inventory from your XenDesktop broker:
a) In the web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Discovery group > All
Discovered Devices.
a) Locate your XenDesktop broker in the list of devices.
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Tip • Adding the VDI broker column from the column chooser, and then filtering on Yes, may help you locate this
server.
a) Click the device's name to open its properties, select the Status tab, and expand the XenDesktop environment
inventory section of the accordion.
This is also the location where any PowerShell script errors from the inventory beacon are reported. Should you need
additional troubleshooting:
•

Inspect the log file on the inventory beacon for errors relating to XenDesktop discovery. This file is located at
%PROGRAMDATA%\Flexera Software\Compliance\Logging\BeaconEngine.

•

Should you need to prepare a trace file to submit to Flexera Software Support, turn on the
Scheduling/RemoteExecution tracing options by editing this file on your inventory beacon:
InstallationDirectory\Flexera Software\Inventory Beacon\etdp.trace

6. As required, you may need to link the file evidence imported from XenDesktop to application records, and ensure that
those application records are linked to license records. Wherever possible, link the license records to purchase records to
identify the number of your license entitlements.
Once all the links are in place, the next compliance calculation reflects your compliance position for applications
accessible through XenDesktop.

Finishing Off
Congratulations! (And there may be a few bits of housekeeping.)
You have achieved a lot.
•

You separated previously co-located installations of two products, and split a shared database.

•

You upgraded your Inventory Manager implementation to 9.2.3 so that it can continue operations.

•

You separated your existing managed devices into two groups:

•

•

•

One group to continue on under Inventory Manager, because they needed customized settings or schedules for their
installed inventory agents

•

A second group to migrate to management by FlexNet Manager Suite 2015.

You implemented FlexNet Manager Suite 2015 in such a way that:
•

All intended managed devices automatically switched over to the new system, and are immediately reporting their
inventory directly to the new inventory database within FlexNet Manager Suite

•

Your continuing implementation of Inventory Manager 9.2 is already set up as an inventory feed into the new system,
in the same way that Microsoft SCCM or IBM's ILMT or other inventory tools can feed your compliance calculations.

Reports have been optimized in the new system, and you may find some in new locations. As well, the system no longer
uses Microsoft Reporting Services for factory-supplied reports, so that some of those reports are no longer available.
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If you have custom reports you developed in Reporting Services, you may need to redirect those to link to your new
compliance (or if combined, operations) database.
If your plan is to continue parallel operations of FlexNet Manager Suite with Inventory Manager continuing as a data source,
your work is complete.
If (on the other hand) you wish to migrate all operations Inventory Manager 9.2 across to FlexNet Manager Suite, some tasks
remain to be completed manually, including these:
•

Scheduled tasks you had established for Inventory Manager are not migrated into FlexNet Manager Suite 2015. In the
new system, you establish rules that combine actions, targets, and schedules. Navigate through Discovery & Inventory >
Discovery and Inventory Rules, and click Create a rule.

•

Of the many specialized remote execution tasks available in Inventory Manager 9.2, only three have equivalent rules
available in FlexNet Manager Suite 2015 (and there is other rule-based functionality not present in Inventory Manager).
If you wish to transfer these three remote execution tasks from Inventory Manager to FlexNet Manager Suite, you must
manually set up the appropriate rules (on the same Discovery and Inventory Rules page mentioned above) to suit your
preferred use of these remote execution tasks:
•

Generate Inventory

•

Generate VMWare Infrastructure Inventory

•

Generate Oracle Database Inventory.

•

If you have a regular process of network discovery to ensure that any new devices are automatically brought under
management, and you want this to transfer to FlexNet Manager Suite, you need to set up matching discovery rules (once
again, on the same Discovery and Inventory Rules page).

•

When you are no longer using Inventory Manager as a data source for FlexNet Manager Suite, you can remove the
connection. Do this (only) on the inventory beacon that is installed on the batch scheduling server (or server hosting that
functionality), opening the Inventory systems page and deleting the connection, by default called ManageSoft. Be sure
to do this ONLY when Inventory Manager is no longer required, and every inventory target has transferred and is actively
managed through FlexNet Manager Suite. This is because removing this connection will also remove from the database
any inventory records still coming exclusively from that source.

In addition to things that require manual effort, there are some other apparent 'gaps' that you may wonder about, but which are
as expected, and do not require manual effort:
•

Historical raw Computer Inventories belong in Inventory Manager and are not transferred to the new system. As managed
devices switch over to 2015, the Discovery & Inventory > All Inventory list (under the Inventory group) is now
populated from their current inventory reports, as expected.

•

Discovered Devices (the list of devices found by Inventory Manager in previous discovery tasks) are all migrated into
FlexNet Manager Suite 2015, with the exception of the following (these are consistent with the normal behavior of 2015):
•

Virtual machines identified in ESX host inventory but which have not yet reported their own hardware and software
inventory

•

Computers with a blank name

•

Computers with a domain name that is blank, or equal to MANAGESOFT or WORKGROUP

•

Computers that have a MAC address that is not unique across your computing estate
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•

Remote devices, mobile devices or VDI templates (these are placeholders created for attaching inventory detected as
use of virtualized applications and virtual desktops)

•

Computers awaiting inventory (that is, records added as assets but not linked to an inventory record).

Your implementation of FlexNet Manager Suite 2015 is now production ready.
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Notes on Issues
Topics:
•

Password Maintenance

•

Identifying IIS Application Pool
Credential Issues

•

IIS Roles/Services

This chapter includes a few brief guidelines for dealing with common issues. If you
discover additional issues not described here, please contact Flexera Software Support
for assistance.
For help on problems uploading inventory data, access the online help through the web
interface for FlexNet Manager Suite, and navigate to FlexNet Manager Suite Help >
Inventory Beacons > Inventory Beacon Reference > Troubleshooting: Inventory
Not Uploading.

Notes on Issues

Password Maintenance
When a password on the service account expires, services cease to operate. At password refresh time, ensure that the password
is updated for all the following services (in a single server implementation, all these are on the application server):
•

On the web application server, in the IIS Application Pool:
•

FlexNet Manager Platform

•

ManageSoftWebServiceAppPool

•

SAP Optimization

•

SAPServiceAppPool

•

On the processing server, in the IIS Application Pool: Flexera Beacon

•

On the processing server, in the FlexNet Manager Platform folder for Microsoft Scheduled Tasks:
•

Data warehouse export

•

Export to ServiceNow

•

Import Active Directory

•

Import application usage logs

•

Import discovery information

•

Import installation logs

•

Import inventories

•

Import Inventory Beacon activity status

•

Import Inventory Beacon status

•

Import remote task status information

•

Import security event information

•

Import SAP inventories

•

Import SAP package license

•

Import system status information

•

Import VDI access data

•

Inventory import and license reconcile

•

Recognition data import

•

Regenerate Business Import config

•

Send contract notifications.
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•

On the batch scheduling server, in Services, FlexNet Manager Suite Batch Process Scheduler and FlexNet Manager
Suite Batch Processor (if you have separated out to multiple batch servers, only the second of these is found on each
batch server)

•

On the server where the inventory processing engine runs (typically also the processing server), in the IIS Application
Pool:
•

Flexera Importers

•

Flexera Package Repository

Note that the configuration scripts cannot be run simply to update passwords. The scripts support the following (space
separated) flags and use cases:
•

Use without a flag to add a configuration file to a new installation; or on an existing implementation, to remove all
customizations and replace the web.config file with the default version:
.\Config.ps1 "Config\FNMS Windows Authentication Config.xml"

•

Add the updateConfig flag to insert any new parameters added by Flexera Software, leaving all settings (including
customizations) unchanged for existing parameters:
.\Config.ps1 "Config\FNMS Window Authentication Config.xml" updateConfig

•

Add the forceUpdateConfig flag to insert any new parameters added by Flexera Software, and restore the default
values for all factory-supplied settings, but leaving any custom parameters unchanged:
.\Config.ps1 "Config\FNMS Windows Authentication Config.xml" forceUpdateConfig

•

Add the removeConfig flag to remove the web.config file before using Windows Programs and Features to
uninstall FlexNet Manager Suite:
.\Config.ps1 "Config\FNMS Windows Authentication Config.xml" removeConfig

Identifying IIS Application Pool Credential Issues
A password change on (any of the) application server(s) may require an update of the IIS configuration.

Background
During installation of an on-premises implementation, PowerShell scripts run on the application server (or, in a multi-server
implementation, on each of the component servers in turn) ask you to provide credentials for the application pools used within
IIS for FlexNet Manager Suite. The scripts save these as part of the IIS configuration.

Note • If, as recommended, you have used a Network Service account for this purpose, it is very unusual to require a
password change for such an account. If you used a normal user account, you require this additional maintenance each time
that the password on that account is changed.
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If, at any time after installation, the password for this user account is updated, the IIS configuration is now out of date, and IIS
will refuse to run the application pools for FlexNet Manager Suite.

Tip • In this case, as well as IIS configuration, you may also need to update passwords on scheduled tasks and on services.
For a complete list, see Password Maintenance on page 76.

Diagnosis
First symptom: The web interface for FlexNet Manager Suite will not load, producing the following error:
HTTP Error 503 - Service unavailable

Investigation: If you examine the Microsoft IIS application pools, you will find that the application pool for FlexNet Manager
Platform is disabled after any attempt to run the web interface. An examination of the IIS log file shows entries like the
following:
server-name 5057 Warning Microsoft-Windows-WAS System date time
Application pool FlexNet Manager Platform has been disabled. Windows Process Activation
Service (WAS)did not create a worker process to serve the application pool because the
application pool identity is invalid.
server-name 5059 Error Microsoft-Windows-WAS System date time
Application pool FlexNet Manager Platform has been disabled. Windows Process Activation
Service (WAS) encountered a failure when it started a worker process to serve the
application pool.
server-name 5021 Warning Microsoft-Windows-WAS System date time
The identity of application pool FlexNet Manager Platform is invalid. The user name or
password that is specified for the identity may be incorrect, or the user may not have
batch logon rights. If the identity is not corrected, the application pool will be
disabled when the application pool receives its first request. If batch logon rights
are causing the problem, the identity in the IIS configuration store must be changed
after rights have been granted before Windows Process Activation Service (WAS) can
retry the logon. If the identity remains invalid after the first request for the
application pool is processed, the application pool will be disabled. The data field
contains the error number.

Repair
Update the credentials for the applications pool on each of your application servers, using the process in Update Credentials in
IIS Application Pools on page 78.

Update Credentials in IIS Application Pools
To update the password for the FlexNet Manager Suite application pools within Microsoft IIS, complete the following process
on each of your servers in turn:

Tip • Servers are here named in a series from most specific (in large scale implementations) to most general (for small scale
implementations). Use the first-listed server type that applies to you. For example, if the list item says "on the inventory
server/processing server/application serve"r, and you have a separate inventory server, make the change there. If you do
not have a separate inventory server, but you have scaled to a separate processing server (that combines your inventory
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server and your batch server), make the change on your processing server. For a single-server implementation, you make this
change on your application server.
1. Open IIS Manager (Start > Administrative Tools > Internet Information Service (IIS) Manager).
2. In the navigation area on the left, expand the SERVER-NAME (account-name) node, and select Application Pools.
Any application pool accessed since the user account password was changed displays a status of Stopped. On each
server type, the relevant application pools are:
•

Flexera Beacon on the batch scheduling server/processing server/application server

•

Flexera Importers on the inventory server/processing server/application server

•

Flexera Package Repository on the inventory server/processing server/application server

•

FlexNet Manager Platform on the web application server/application server

•

ManageSoftWebServiceAppPool on the web application server/application server

•

SAP Optimization on the web application server/application server

•

SAPServiceAppPool on the web application server/application server.

3. Select the appropriate application pool, and in the Actions list on the right, click Advanced Settings.
The Advanced Settings dialog appears.
4. In the Process Model section, select Identity, and click the ellipsis button next to the account name.
5. Next to Custom Account, click Set.
The Set Credentials dialog appears.
6. Enter the full User name for the account and enter the updated password in the two required fields.
7. Click OK to close all the open dialogs and save the new settings.
8. With the appropriate application pool still selected, in the Actions list on the right, click Start.

IIS Roles/Services
Below are the Microsoft Internet Information Services (IIS) roles and services utilized by FlexNet Manager Suite. In the event
of misbehavior, it is often helpful to validate that all of the following are enabled on all your central servers (depending on the
scale of your implementation, the ones that you have implemented from the application server, the web application server, the
processing server, the batch scheduling server, and the inventory server). The process for checking whether the services are
enabled is summarized below the list.
•

Web Server > Application Development > .NET Extensibility

•

Web Server > Application Development > ASP.NET

•

Web Server > Application Development > CGI

•

Web Server > Application Development > ISAPI Extensions

•

Web Server > Application Development > ISAPI Filters

•

Web Server > Common HTTP Features > Default Document
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•

Web Server > Common HTTP Features > Directory Browsing

•

Web Server > Common HTTP Features > HTTP Errors

•

Web Server > Common HTTP Features > HTTP Redirection

•

Web Server > Common HTTP Features > Static Content

•

Web Server > Health and Diagnostics > HTTP Logging

•

Web Server > Performance > Dynamic Content Compression

•

Web Server > Performance > Static Content Compression

•

Web Server > Security > Basic Authentication

•

Web Server > Security > Request Filtering

•

Web Server > Security > Windows Authentication

To check whether these services are enabled in the Windows Server operating system:
1. Starting from the Windows start menu, navigate to Control Panel > Administrative Tools > Server Manager.
2. In the navigation bar on the left, under the Server Manager node, select the Roles node.
3. Locate the Web Server (IIS) section, and within that, identify the Role Services section.
This section lists the status for each service. All of those in the list above should be both installed and enabled on all your
central servers.
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